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1

Welcome to 
Access Vision

Introduction
Access Vision is a new access control 
application suite for Picture Perfect, providing 
full operator, facility, and permission 
administration. Many related functions are 
combined together into a single application.

Access Vision is a Microsoft Windows-based 
application suite that allows management of 
Picture Perfect sites from your desktop. The 
GUI communicates directly with a Picture 
Perfect site using TCP/IP protocol. 

Among the features Access Vision offers:

p Device management.

p Streamlined configuration tools.

p Complete monitoring capabilities.

p Site administration.

p Simplified badge management and 
administration.
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System Requirements
Access Vision supports stand-alone, network, 
and redundant Picture Perfect configurations.

Hardware Requirements

p PII 200 MHz or faster processor 

p 64 megabytes of RAM (96 MB recommended 
for Windows 98 Second Edition, 128 MB for 
Windows NT 4.0 Workstation)

p 1024X768X16 bit color

p 25 MB of available disk space

p Sound card (optional)

Software Requirements

Server (Picture Perfect)

p Server running either:
• UnixWare 2.1.3

• IBM AIX 4.2.1

p Picture Perfect 1.5.5 or later
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Client (Access Vision)

p Client running either:

• Windows NT 4.0 Workstation with 
Service Pack 6a installed. 
(Recommended)

• Windows 98 Second Edition

p Internet Explorer 4.01 or later

Other Prerequisites

p TCP/IP must be installed and operational

p The Picture Perfect user account install 
must be present and enabled before 
installing the Access Vision product.

p Swap file space:

• Minimum: 100 MB

• Maximum: 250 MB

1_system_overview.backup.fm  Page 3  Friday, July 7, 2000  3:00 PM



Related Documentation

Access Vision User’s Guide1.4

Related Documentation
For more information, refer to the following:

PICTURE PERFECT ADMINISTRATION GUIDE

This guide provides extensive reference 
information on Picture Perfect which stores the 
database used with Access Vision. 

ACCESS VISION ONLINE HELP SYSTEM

The online help system provides reference 
information, such as screen and field 
descriptions, along with instructions for system 
administrator duties, such as configuring micros.

ACCESS VISION IMAGING PLUG-IN 1.0 USER’S 
GUIDE

This manual provides information on how to use 
the Imaging system to design badges as well as 
setup and configuration information.

ACCESS VISION AND ACCESS VISION IMAGING 
INSTALLATION GUIDE

This manual provides detailed information on 
how to install Access Vision and/or Access 
Vision Imaging in new as well as existing 
system configurations.

+ For 
detailed 
information on 
Picture Perfect.

+ Information 
about menus, 
screens and 
fields.

+ Information 
about using the 
Imaging system 
to create and 
design badges.

+ Information 
about installing 
and upgrading to 
Access Vision 
and/or Access 
Vision Imaging.
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Notational and Typographical
Conventions

This manual uses certain notational and 
typographical conventions to make it easier for 
you to identify important information. 

Table 1-1:  Notational and Typographical Conventions 

Item Example

Menu Titles, 
Menu Items, 
Field Names, 
Form Titles

Administration

Keys

Buttons OK

Text you 
enter

Micro 1

To reduce the confusion between similar numbers and 
letters, namely the number 1 and the lowercase letter l 
along with the number 0 and the letter O, refer to the 
following list:

1234567890
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

+ Provides important information in a concise manner. 
The graphic is displayed on the left side of the page 
followed by the information.

Enter
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Notes Provides additional information. The following graphic is 
displayed on the left side of the page:

Caution Provides information you should know to avoid potential 
problems, before continuing. The following graphic is 
displayed on the left side of the page:

Warnings Provides information you MUST know to avoid 
consequences of a disastrous nature, before 
continuing. The following graphic is displayed on the left 
side of the page:

Instructions Provides instructional information in a step-by-step 
format.

Application Provides a visual reference to the application being 
discussed by displaying the icon.

Table 1-1:  Notational and Typographical Conventions  

Item Example
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Getting Started

Quick Start
Once your installation is complete, the 
following steps will get you started using 
Access Vision for the first time. Each of these 
steps will be discussed in detail in the following 
sections.

1. Double click the Access Vision icon on 
the Windows desktop to display a Login 
Screen.

Result: Following a successful login, a 
Facility Selection screen will display.

2. Choose one or more facilities to be used 
with the applications.

Result: Your Access Vision session 
begins with the presentation of the 
Application Launcher from which all 
client applications are started. 

3. Single click an icon representing an 
application. 
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Logging In
In order to use Access Vision, the new graphical 
user interface to Picture Perfect, you must log in 
to an authorized terminal as a Picture Perfect 
operator. The User ID combined with your 
Password tells the system who you are and 
which functions you are authorized to perform. 
Both of these fields are case sensitive, so enter 
the information carefully.

1. Fill in the following fields in the Session 
Login window:

Figure 2-1.  Login Screen

User ID
Enter your Picture Perfect User ID. This 
typically incorporates your name and 
consists of an alphanumeric string of up to 
eight characters. 
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Password
Enter your Picture Perfect Password. It 
usually consists of 6 to 8 characters and, for 
security reasons, does not display on the 
screen as you type it. Your password should 
remain confidential as it keeps unauthorized 
personnel from logging onto the system. 

Host
Click on the down arrow to select a Picture 
Perfect host name. The most recently 
accessed hosts are displayed.

Language
Click on the down arrow to select the 
language to be used in this session. The 
drop-down list will display all languages 
supported by client software applications. 
When you log onto the system for the first 
time by entering your User ID, the local 
language of the installed operating system 
will be displayed as the default language for 
the session in the drop-down list. You may 
change the language before starting the 
log-in operation. When login validation has 
completed successfully, your language 
preference will appear as the default 
language on subsequent logins.
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2. Select one of the following options:

p Click OK to accept your entries and 
continue the session.

p Click CANCEL to quit the session and exit 
back to the Windows desktop.

Upon successful login, the host will provide the 
list of facilities accessible to you. 

Facility Selection
After successfully logging in to an Access 
Vision session, choose the facilities you wish to 
manage.

Figure 2-2.  Facility Selection Screen

1. Highlight a single facility by clicking on it or 
multiple facilities by holding down the  
or  key while highlighting your 
selection(s). To select a single facility from 
this list, double-click on it.

Shift

Ctrl
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2. Select one of the following options:

p Click OK to select the highlighted facility 
or facilities.

p Click CANCEL to close this window 
without selecting a facility.

p Click SELECT ALL to highlight all facilities 
displayed.

p Click UNSELECT ALL to remove the 
highlight from all selected facilities.

If, after the initial login, you want to change the 
facility selection for one or more applications, 
this screen can be accessed by clicking File, 
Change Facilities from the Launcher menu bar. 
Any applications launched before the change 
will retain the original facility selection and any 
applications launched after the change will have 
the new selection. You may change them again, 
if desired. 

To view the currently selected facilities from 
any application, click View, Facilities from the 
application menu bar, or type: L. Ctrl
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Redundant System Operation
Redundant Picture Perfect systems require two 
Access Vision workstations, one on each 
network. For normal operations, one 
workstation should be logged into the primary 
host, and the other logged into the backup host. 
While logged on to the primary server, the 
operator runs in primary mode.  Primary mode 
operation is the same as normal operation on a 
stand-alone system.  It will use the application 
permissions as defined for the operator. While 
logged on to the backup server, the operator can 
only run in backup mode.  Backup mode gives 
View record level permission for all 
applications. This View record level permission 
supersedes any application permissions defined 
for the operator. For example, if the operator 
normally had Update, Insert, or Delete record 
level permission to a table, they would be 
reduced to View record level permission. If the 
operator had record permission level None, it 
would remain None. 

Non-database type applications operate in a 
redundant system as follows:

System Monitor 
Because micros do not respond to 
communications from a backup host, the 
System Monitor is available only from the 
primary host.

Activity Monitor 
Because activity data is not stored in the 
shared memory area of the backup host, the 
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Activity Monitor is available only from the 
primary host.

Alarm Monitor 
Operators can respond to, as well as purge, 
alarms from both the primary and the 
backup host.

Reports 
Operators have full report capability from 
both the primary and the backup host. 

See the PICTURE PERFECT REDUNDANT SYSTEM 
ADMINISTRATION GUIDE for a more complete 
discussion of the operations that are permitted 
on backup server tables. These architectural 
restrictions supersede any specific table 
permissions granted to the operator by the 
System Administrator via the permission 
assigned to the operator.

NOTE

Direct SQL reports are saved locally to the 
Access Vision client PC, not to the host. 
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CAUTION

In a redundant Picture Perfect system, if the 
host the terminal is logged into goes down, the 
Access Vision terminal will cease to function 
properly. A system using Access Vision 
terminals to monitor and recover from a system 
failover, must have two Access Vision 
terminals, one connected to the primary host, 
and the other to the backup host. Each should 
be on a separate network. This way the 
operator can access the live system from the 
Access Vision terminal that is connected to it. 

For detailed information on Access Vision 
operation during a system failover, see 
See Appendix A - Failover in a Redundant 
System
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Network System Operation
In a network system an operator will log on to 
Access Vision, choosing one host to work from 
at a time.  If the host is a sub-host, they will only 
see alarms, micros, and devices that originate 
from that sub-host.  If the host is the network 
host, they will be able to see all alarms, since all 
the alarms are routed from the sub-hosts to the 
network host.  Creation of micros and devices 
on a network host is not allowed, since you are 
not allowed to connect a micro to the network 
host. Similar restrictions apply for creating 
facilities, categories, permission groups and for 
deleting badge records. 

Non-database type applications operate in a 
network system as follows:

System Monitor 
Because micros and devices do not exist on 
the network host, the System Monitor is 
available only on the sub-host.

Activity Monitor 
Operator and Swipe and Show activity can 
be monitored when working from both 
network hosts and sub-hosts. Badge and 
Tour activity can be monitored only from 
the sub-host. 

Alarm Monitor 
Operators have full alarm response and 
purge capability from both network hosts 
and sub-hosts.
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Reports 
Operators have full report capability from 
both network hosts and sub-hosts. 

The optional Imaging package operates in a 
network system as follows:

Imaging
If you have the IMAGE package installed on 
your network system, the imaging features 
available will depend on whether the host is 
an IMAGE server or not. The IMAGE server 
is the host where the IMAGE database 
resides, and has read-write access to it. All 
other hosts in the system have read-only 
access.

Badges
Images can be loaded and viewed from any 
host in the system. The following features 
are only available when logged into the 
IMAGE server:

• Image capture.

• Badge printing.

• Edit/Create badge designs.

• Edit/Create design mappings.

• Reissue badge.

• Clone a badge record.

2_Getting Started.fm  Page 10  Wednesday, June 7, 2000  12:14 PM



Getting Started

Access Vision User’s Guide 2.11

2

See the PICTURE PERFECT NETWORKING GUIDE for 
a more complete discussion of the operations 
that are permitted on network host and sub-host 
server tables. These architectural restrictions 
supersede any specific table permissions 
granted to the operator by the System 
Administrator via the permission assigned to 
the operator.
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The Application Launcher
The Application Launcher provides a starting 
point from which Windows Picture Perfect 
clients can remotely access a Picture Perfect host 
computer within a stand-alone, redundant, or 
network system. Typically, Access Vision will 
group several related existing Picture Perfect 
applications within a single Access Vision client 
application, allowing you to manipulate all data 
from the respective host database tables from 
one application.

The desktop consists of an Application 
Launcher that provides login and facility 
selection windows and, following a successful 
login, a window containing icons representing 
the various client applications available under 
Access Vision. The Launcher provides the 
ability to execute client applications, to log 
on to other hosts that are part of the same 
Picture Perfect system (network or redundant) 
and to switch between those hosts whenever 
desired. 

Each toolbar button in the window represents a 
specific Access Vision client application. Only 
those applications to which an operator has 
permission and only those actions that an 

NOTE

Only one instance of Access Vision at a time 
can be run from a client PC. The operator must 
log off and log in to the new host in order to 
change hosts.
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operator has permission to perform will be 
available. These permissions are established at 
login. When launched, an Access Vision 
application accesses the Picture Perfect host and 
is able to retrieve, update, insert, or delete files 
and records. Communication between each 
application and the selected host is independent 
from all other active client applications.

Figure 2-3.  Application Launcher

The Application Launcher window consists of 
the following:
Menu Bar

A main menu providing session operations 
such as selecting a facility or logging off.

Host Indicator 
Reflects the current host.

Application Toolbars
Contains icons that activate client 
applications.
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The Main Menu
The Launcher’s main menu is used to perform 
session operations.

File Menu

Change Facilities
Select this item to change the currently 
selected facilities for one or more 
applications. Any applications launched 
before the change will retain the original 
facility selection(s) and any applications 
launched after the change will have the new 
selection(s). 

To view the currently selected facilities 
from any application:

From the application menu bar, click View, 
Facilities or type: L.

Save Desktop
Select this item to save the settings currently 
in effect on your Access Vision desktop. 
These settings include the applications that 
are open as well as their location on the 
screen. The default is a blank desktop in 
which all applications are closed. The 
settings will be saved based on the 
operator/host login, which allows you to set 
up user profiles so that when one person 

Ctrl
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logs on, their personal Access Vision 
settings are used. For example, one operator 
may prefer to have certain applications 
appear when they log on because those are 
the only ones with which he is concerned. 
He may want to access another set of 
applications every time he connects to 
another Picture Perfect host. Another 
operator may want to access different 
applications on each login. The settings can 
be reset at any time by reapplying this 
option.

The Save Desktop function applies to the 
currently selected host. If you are logged 
onto multiple hosts, perform a Save Desktop 
for each host.

Log Off
Select this item to terminate all client 
applications and to log off the currently 
selected host. A confirmation dialog will be 
presented for verification. The session will 
be terminated and a new Log In window 
will be displayed.

Change Password
Select this item to change your password. 
Your password is a key element of security, 
so if you suspect that someone might know 
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it, you should change it immediately. Fill in 
the following fields:

Figure 2-4.  Change Password

To change your password:

1. Type your old password.

2. Type your new password, and then type 
it again in the Confirm Password box.

3. Click on OK.

Exit
Select this item to end the current session 
and return to your Windows desktop. When 
this menu item is selected, a confirmation 
dialog displays. If the Exit action is 
confirmed, the Application Launcher will 
terminate the session and exit the Access 
Vision desktop.
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Edit Menu
Preferences

Select this item to quickly change session 
properties for Communications parameters 
or Applications parameters.

• Communications

Figure 2-5.  Communications Preferences

Remote Procedure Call (RPC) Parameters
RPC service retries
The number of times the RPC operation 
will retry (after the time-out has expired) 
before the user is notified. 
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Standard query and update timeout
The number of seconds the server will 
wait for a service to complete before 
returning a response for a search. 

Query with option flags timeout
The number of seconds the server will 
wait for a service to complete before 
returning a response for a search with 
option flags set. (Option flags are fields 
represented by a checkbox or a radio 
button.) 
Update host timeout
The number of seconds the server will 
wait for a service to complete before 
returning a response when saving 
changes to the host database. 
Image/File retrieval and update timeout
The number of seconds the server will 
wait for a service to complete before 
returning a response, when retrieving a 
photo, signature, badge design, or other 
file from the host. 
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Component Object Model (COM) 
Parameters

COM service retries
How many times the COM operation 
will retry (after the timeout has expired) 
before the user is notified. 
COM service timeout
The number of seconds the COM client 
will wait for the COM server to respond 
before timing out. 
OK

Click to save your changes and exit the 
dialog.
CANCEL

Click to exit the dialog without saving 
your changes.

NOTE
These parameters should only be changed if 
you are experiencing problems such as 
Server busy or COM timeout.
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• Applications

Figure 2-6.  Applications Preferences

Maximum records returned from host by a 
query

The number of records that can be 
returned by a Search operation. The 
minimum is 16; the maximum is 256.
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Row selection options
Allow multiple row selections
When checked, the user can select 
multiple rows displayed in the grid after 
a Search operation. The default is to 
allow multiple selection.

Delete record options
Prompt before delete
When checked, a confirmation dialog 
will be displayed before a Delete is 
executed. The default is to display a 
prompt.

The host records are not deleted until the 
SAVE button is pressed.

NOTE
Operators should take great care when 
increasing this value, as it may greatly increase 
the amount of data transferred from the server, 
slowing performance. If changes are made to a 
very large number of records, some 
operations, such as resetting badge APB 
status or opening doors,  may introduce 
loading problems on the server. For example, 
changing APB status at the same time for a 
large number of badges known to many dial-up 
micros, could significantly increase 
communications loading as the host attempts 
to dial those micros. 
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OK

Click to save your changes and exit the 
dialog.

CANCEL

Click to exit the dialog without saving 
your changes.

The Host Indicator
This box indicates the currently selected host. 
When an application is launched from the 
toolbar, this is the host database that will be 
accessed.

The Application Toolbars
The applications available in Access Vision are 
displayed in this window in the form of icons 
grouped according to their function. There are 
currently five Application Toolbars: 
Configuration, Devices, Monitoring, 
Administration, and Badging.

Each of the applications launched by the icons 
on these toolbars will be discussed in further 
detail in the following chapters.
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Configuration

This toolbar contains three application icons: 
Alarms, Areas, and Modes.

Click on the Alarms icon to launch the Alarm 
Configuration and Scheduling application 
which allows the operator to define and 
configure alarms and to schedule alarm events. 
Use it to:

• Specify alarm details by configuring the 
appearance of an alarm.

• Specify alarm options.

• Specify alarm instructions.

• Schedule a new alarm event or edit an 
existing event.

• View, enter, or change information about an 
alarm event.

• Create or edit an alarm response.
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Click on the Areas icon to launch the Area 
Configuration and Scheduling application 
which is used to configure areas and area 
events. Use it to:

• Define and maintain area configuration 
information, such as Description, Routing, 
Input groups, and Categories.

• Control the status of areas.

• Define and maintain area event 
configuration information.

• Create and schedule area events. 

Click on the Modes icon to launch the Mode 
Change and Scheduling application. This 
application can be used to:

• Add or rename any of the defined Picture 
Perfect modes. 

• Select a mode to be activated manually or set 
up for scheduled mode changes. 
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Devices 

This toolbar contains four application icons: 
Doors, I-O Groups, Micros, and Readers.

Click on the Doors icon to launch the Door 
Configuration and Scheduling application 
which allows the operator to add, delete, or 
modify doors in the system and set different 
characteristics for each door as well as door 
scheduled events. Use it to:

• Define the door details, such as Door Area, 
Strike Output, and Facility.

• Set the door control settings, such as Door 
State, Scheduling, or Held Open Sensing.

• Set the Door Strike Relock options.

• Assign input groups for the various door 
transactions.

• Create door events to control defined door 
components, such as Forced Open 
Monitoring. 
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Click on the Inputs/Outputs icon to launch the 
Input, Output, and Input and Output Groups 
application. Use this option to:

• Create new Inputs.

• Modify Input Groups.

• Assign Outputs or Output Groups.

• Create Input Group events.

• Create Output Group events.

Click on the Micros icon to launch the Micro 
Configuration application. This application 
allows the operator to define characteristics, 
such as communication retries, polling interval, 
port assignment, and addresses for micros. Use 
it to:

• Add or change a micro.

• Configure the micro for dial-up and network 
communications.

• Associate micro error conditions with input 
groups. 
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Click on the Readers icon to launch the Reader 
Configuration application which allows the 
operator to define reader characteristics, such as 
board number, address, interval time, logical 
reader function, and physical reader type. Use it 
to:

• Add or change a reader.

• Assign the reader to a micro.

• Configure the reader to trigger a selected 
input group.

Monitoring 

This toolbar contains three application icons: 
System, Alarm, and Activity.

Click on the System icon to launch the System 
Monitor. Use this application to view the 
current status of selected devices such as:

• Micros

• Doors

• Inputs

• Readers 

Click on the Alarm icon to launch the Alarm 
Monitor. Use this application to view incoming 
alarms and their priority, count, status, and time 
of occurrence. 
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Click on the Activity icon to launch the Activity 
Monitor. Use this application to view badge, 
trace, operator, tour, swipe and show, or any 
combination of activities.

Administration

This toolbar contains four application icons: 
Operators, Partitions, Permissions, and 
Reports.

Click on the Operators icon to launch the 
Operators application which allows the user 
(typically the system administrator) to assign 
permissions to an operator. Use it to control the:

• Facilities the operator may use to access the 
database.

• Applications the operator may execute.

Click on the Partitions icon to launch the 
Partitions application which allows the system 
to be grouped according to facility, permission 
group, or category.  Use this application to 
define:

• Facility records.

• Permission groups. 

• Categories of people who use a facility and 
their associated permission groups.
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Click on the Permissions icon to launch the 
Permissions application which controls the level 
of operations (View, Update, Insert, Delete) that 
can be performed on database table records on a 
per application basis as well as on a field level 
basis. Use this application to define and edit:

• Application permission settings. 

• Field level permission settings.

Click on the Reports icon to launch the Reports 
application. Use this application to create and 
view reports.

Badging 

This toolbar contains one application icon: 
Badges.

Click on the Badges icon to launch the Badges 
application. Use this application to issue badges 
and to control their function and capability.
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The Application Window
The majority of Access Vision applications, 
specifically those that provide access to and 
manipulation of objects defined in the Picture 
Perfect database tables, are based on a common 
framework. All Access Vision application 
windows share several common characteristics 
and components. Learning how to use these 
windows allows the operator to quickly master 
all components of the Access Vision desktop.

A typical Access Vision application interacts 
with the operator through a standard main 
application window as illustrated below. 

Figure 2-7.  Application Window
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The Application Title Bar
The Application Title Bar identifies the name of 
the Access Vision application and the host 
Picture Perfect system with which the 
application is exchanging data. If you are 
communicating with a network host or subhost, 
or a primary or backup host, it will be identified 
in this area as well.

The Menu Bar
The Menu Bar contains a standard File, Edit and 
View menu, providing access to all application 
functions.

File Menu

New
This will create a new record. The record 
will be added as the last row in the Record 
List. The dialog panels in the Panel Area of 
the Form Window will be automatically 
filled in with any default values for the new 
record, or cleared if there is no default. If 
any of the fields are required, the name of 
the field will be listed in the Status Window, 
and the Errors icon  will appear by its 
row in the Record List. Once the required 
fields are filled in, the New Record icon  
will appear by the row.
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You must have Insert record permission to 
create a new record, and Update permission 
on all required fields. While in Search mode, 
the New command remains available. 
Selecting New will exit from Search mode 
into Edit mode, and create a new record. 

Clone
This will create a new record and copy the 
values of the currently selected record to it. 
This is a quick way to create a new record 
that is to be similar to an existing record. A 
record must be currently selected in order to 
clone it. If multiple records are selected, a 
new cloned record will be created for each 
one selected. The cloned records will be 
placed at the bottom of the Record List and 
marked with the New Record icon .

You must have Insert record permission to 
clone a record. Only fields that you have 
permission for will be copied to the new 
record.

Save
This will save all current changes to the host. 
The Save function will only become enabled 

+ After 
cloning a record, 
be sure to 
update any 
fields, such as 
description, 
that are 
required to be 
unique.

NOTE

For Badge records, if Imaging is installed on 
the host, you must be logged into the IMAGE 
server to clone a badge.
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once all pre-save errors in the Status 
Window have been resolved, such as all 
required fields must be filled in and no 
fields can exceed their maximum length. 
Any problems that occur while saving to the 
host will be logged to the Status Window.

You must have Update record permission to 
save any changes.

New Search
This will clear the dialog panels in the Panel 
Area of the Form Window and enter into 
search mode. All option settings are set to an 
indeterminate (unselected) state. Any fields 
for which values are entered or options are 
selected will be added to the search criteria. 
Select Search to initiate a search of the host 
database table using the specified criteria. 
While in search mode, the Record List will 
be disabled. Selecting New Search again will 
re-clear all the fields.

You must have View record permission to 
search. You must save any changes before 
selecting a new search. When an application 
is started, New Search is selected, by default. 
This puts the operator in search mode which 
allows him to select the desired records.

Search
Once in search mode, the Search function 
becomes enabled. After entering the search 
criteria, click Search. If no fields are filled in, 
it will return all records within the host 

+ This 
selection 
performs the 
same function 
as that 
performed by 
selecting Clear 
from the Edit 
menu.
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database table, up to the maximum set in the 
Launcher preferences. Once Search is 
selected, no other operations can be 
performed while searching. After searching, 
the Record List will be redrawn containing 
all records found. If no records were found 
the application remains in search mode. 
Otherwise the application enters edit mode. 

You must have View record permission to 
search.

Exit Search
This will exit from search mode back to edit 
mode without performing the search. The 
records in the Record List window will 
become enabled, and the records previously 
selected will have their values displayed in 
the dialog panels of the Panel Area in the 
Form Window.

In order for Exit Search to be enabled, you 
must currently be in search mode and have 
records displayed in the Record List 
window to edit. 

Edit Menu

Copy
This will copy the values of the currently 
selected records to be used by Paste. 

You must have Update record permission to 
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copy a record. Only fields that you have 
Update permission for will be copied.

Paste
This will paste the values of previously 
copied records to the currently selected 
records.

You must have Update record permission to 
paste a record. Only fields that you have 
Update permission for will be updated with 
the pasted value.

Delete
This will mark the selected records for 
deletion. If any of the records are new, (via 
New or Clone) it will ask if you wish to 
delete them now. Previously existing 
records (in the host database) will only be 
deleted upon saving. If a record is marked 
deleted, any edits to it are ignored. Deleted 
records are marked with the Deleted icon 

. 

You must have Delete record permission to 
delete a record and the record table must 
support deletion.

Undelete
This will unmark the selected records for 
deletion. Changes that were made to the 
record will be validated, and the deleted 
icon will be removed. Note that if validation 
errors occur, the Deleted icon  will be 
replaced by an Errors icon . 
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Restore
This will restore the currently selected 
records in the Record List window to their 
original state. All changes will be undone.

Clear
This will clear the dialog panels in the Panel 
Area of the Form Window and enter into 
Search mode. All option settings are set to an 
indeterminate (unselected) state. While in 
Search mode, the Record List will be 
disabled. 

View Menu

Toolbar
This will display or hide the toolbar. To 
display the toolbar, select this option; to hide 
the toolbar, deselect it.

Status Bar
This will display or hide the status bar. To 
display the status bar, select this option; to 
hide the status bar, deselect it.

Grid Lines
This will turn off or on the vertical and 
horizontal grid lines used to separate the 
records and fields in the Record List 
window.

Grid Columns
Selecting this option will display the 
following dialog which allows you to select 

+ This 
selection 
performs the 
same function 
as that 
performed by 
selecting New 
Search from 
the File menu.
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the columns and the order in which they are 
to be displayed in the Record List window.

Figure 2-8.  Grid Columns

To add a field column to the grid, double 
click the desired field in the Available Fields 
list box or single click the field and press 
ADD. 

To remove a field column from the grid, 
double click the desired field in the Selected 
Fields in Column Order list box or single 
click the field and press REMOVE.
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To change the order of the field columns on 
the grid, click the field column to be moved 
in the Selected Fields in Column Order list 
box and press  or to move the field. 
Moving a field up in the list brings that 
column closer to the beginning (left most 
part) of the grid.

Refresh
This will refresh the contents of the Record 
List window by re-performing the last 
search. You must save any changes before 
performing a refresh.

You must have View record permission to 
refresh.

Synchronize views
This option is used to display associated 
records when more than one host database 
table is included in an application (indicated 
by more than one top-level item in the 
Navigation Tree). The records included in 
one top-level item are independent of the 
records included in another top-level item.

For example, in the following figure, the 
records displayed when a search is 
performed on the Doors item, are not 
displayed when you select the Schedule 
events item. 
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Figure 2-9.  Synchronize Views (1)

Figure 2-10.  Synchronize Views (2)

By selecting Synchronize views from the 
View menu, all records in the Schedule 
events host database table that are 
associated to the selected record (000-1-00 
DOOR 1 in our example) from the Doors 
host database table, will be retrieved and 
displayed as shown in the following figure.
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Figure 2-11.  Synchronize Views (3)

Facilities
This will display the Selected Facilities 
dialog, which displays the currently selected 
facilities for this application.

2_Getting Started.fm  Page 40  Wednesday, June 7, 2000  12:14 PM



Getting Started

Access Vision User’s Guide 2.41

2

The Toolbar 
The toolbar contains buttons that allow the 
operator to quickly perform typical operations, 
such as searching the host database or creating 
new records.

New
This will create a new record. The record 
will be added as the last row in the Record 
List. The dialog panels in the Panel Area of 
the Form Window will automatically be 
filled in with any default values for the new 
record, or cleared if there is no default. If 
any of the fields are required, the name of 
the field will be listed in the Status Window, 
and the Errors icon  will appear by its 
row in the Record List. Once the required 
fields are filled in, the New Record icon  
will appear by the row. 

You must have Insert record permission to 
create a new record, and Update permission 
on all required fields. While in Search mode, 
the New command remains available. 
Selecting New will exit from search mode 
into edit mode, and create a new record. 

Clone
This will create a new record and copy the 
values of the currently selected record to it. 
This is a quick way to create a new record 
that is to be similar to an existing record. A 
record must be currently selected in order to 
clone it. If multiple records are selected, a 
new cloned record will be created for each 
one selected. The cloned records will be 

+ After 
cloning a record, 
be sure to 
update any 
fields, such as 
description, 
that are 
required to be 
unique.
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placed at the bottom of the Record List and 
marked with the New Record icon .

You must have Insert record permission to 
clone a record. Only fields that you have 
permission for will be copied to the new 
record.

Save
This will save all current changes to the host. 
The Save function will only become enabled 
once all pre-save errors in the Status 
Window have been resolved, such as, all 
required fields must be filled in and no fields 
can exceed their maximum length. Any 
problems that occur while saving to the host 
will be logged to the Status Window. 

You must have Update record permission to 
save any changes.

Copy
This will copy the values of the currently 
selected records to be used by Paste. 

You must have View record permission to 
copy a record. Only fields that you have 
View permission for will be copied.

NOTE

For Badge records, if Imaging is installed on 
the host, you must be logged into the IMAGE 
server to clone a badge.
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Paste
This will paste the values of previously 
copied records to the currently selected 
records. 

You must have Update record permission to 
paste a record. Only fields that you have 
Update permission for will be updated with 
the pasted value.

Delete
This will mark the selected records for 
deletion. If any of the records are new, (via 
New or Clone) it will ask if you wish to 
delete them now. Previously existing 
records (in the host database) will only be 
deleted upon saving. If a record is marked 
deleted, any edits to it are ignored. Deleted 
records are marked with the Deleted icon 

.

You must have Delete record permission to 
delete a record and the record table must 
support deletion.

Undelete
This will unmark the selected records for 
deletion. Changes that were made to the 
record will be validated, and the deleted 
icon will be removed. Note that if validation 
errors occur, the Deleted icon  will be 
replaced by an Errors icon . 

You must have Delete record permission to 
undelete a record.
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Clear
This will clear the dialog panels in the Panel 
Area of the Form Window and enter into 
search mode. All option settings are set to an 
indeterminate (unselected) state. While in 
search mode, the Record List will be 
disabled. 

You must have View record permission to 
search. You must save any changes before 
selecting a new search. By default, when an 
application is started, Clear has already been 
selected so that the operator is in search 
mode to select the records to work with.

Search
Once in search mode, the Search function 
becomes enabled. Any fields for which 
values are entered or options are selected 
will be added to the search criteria. After 
entering the search criteria, press the Search 
button. If no fields are filled in, it will return 
all records within the host database table, up 
to the maximum specified in Launcher, 
Preferences (See "Maximum records 
returned from host by a query" on page 
2.20). Once Search is selected, no other 
operations can be performed while 
searching. After searching, the Record List 
will be redrawn containing all records 
found. If no records were found the 
application remains in search mode. 
Otherwise the application enters edit mode. 

You must have View record permission to 
search.
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Search Criteria
When performing a search for data, you 
may wish to view all records or only certain 
records. Prior to pressing the Search button, 
search criteria may be entered as follows:

Text boxes 

A blank text box will return all records.

A text box containing text will only 
return records that contain the text 
specified.
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The following wildcards and operators 
can be used in a text box (Note that * and 
% function exactly the same):

The following comparison operators can 
be used in numeric fields:

_ For example, to search for any 2 characters 
ending with the letter A, enter:  _A

* For example, to search for text beginning with 
the letter A followed by any sequence of 
characters, enter:  A*

% For example, to search for text beginning with 
the letter A followed by any sequence of 
characters, enter:  A%

^ For example, to search for text beginning with 
the letter A or B, enter:  A*^B*

> Greater than For example, to locate records with a value greater 
than 3, enter:  

>= Greater than 
or equal to

For example, to locate records with a value greater 
than or equal to 3, enter: 

< Less than For example, to locate records with a value less 
than 3, enter: 

<= Less than or 
equal to

For example, to locate records with a value less 
than or equal to 3, enter: 

!= Not equal to For example, to locate records with a value not 
equal to 3, enter: 
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Radio Buttons

Checkboxes

Selecting radio buttons limits the search to 
records with matching selections.

Deselecting radio buttons indicates that the 
criteria is not to be included in the search.

Enabling checkboxes limits the search to 
those records that have those options 
enabled.

Disabling checkboxes limits the search to 
those records that have those options 
disabled.

Leaving the checkbox as is, with the ? , 
indicates the value in this field does not 
participate in the search.

NOTE

With the exception of the PIN field and the 
Employee ID field, wildcards cannot be used 
in numeric fields, such as Shunt time.
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Drop-down lists
Selecting an item from a drop-down list 
will limit the search to records with 
matching selections.

A blank drop-down list does not limit 
the search.

List Windows
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• Adding an item(s) from the Available 
window to the Selected window limits the 
search to those records with matching 
selections.

• If more than one item is Selected, the search 
is limited to those records containing all of 
the selected items in the exact order shown.

• A blank Selected window does not limit the 
search.

NOTE

Multiple items can be selected as search 
criteria. These items can be selected from 
different dialog panels as long as they 
correspond to the same top-level item (the 
same host database table) in the Navigation 
Tree. For example, in the Areas application 
under Area configuration, search criteria for a 
single search can be selected from the 
Properties, Input groups, Routing, and 
Categories panes.
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The Form Window
The Form Window provides the primary means 
by which an operator interacts with an 
application. It allows direct access to all fields 
within a single record or a selection of records 
from a host database table via the Panel Area.

The Panel Area contains one or more dialogs 
used to display or allow modification of the 
fields within a record. The number of dialogs 
varies according to the host database table being 
manipulated. An application may provide 
manipulation of more than one host database 
table.

The operator can select which host database 
table he or she wishes to access via the 
Navigation Tree. There is an entry in the 
Navigation Tree for each dialog of each host 
database table to which the application provides 
access.

Navigation Tree

The Navigation Tree organizes and provides 
direct access to the dialog panels, which provide 
display and editing of the fields in a host 
database table record. The number of dialog 
panels depends on the number of fields in a 
record of the host database table. Clicking on an 
item in the tree will bring the corresponding 
dialog panel to the top of the Panel Area. The 
currently displayed dialog panel is always 
highlighted in the Navigation Tree.
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Multi-Table Applications

In some applications, more than one host 
database table can be edited from the 
application.  Generally, this will be indicated by 
more than one top-level item in the Navigation 
Tree.  If you select an item in the Navigation 
Tree whose corresponding dialog panel belongs 
to a different host database table than the one 
the operator is currently working on, you will 
be asked if you want to save your changes to the 
current table before displaying the new dialog 
panel. You can choose to save your changes YES, 
discard your changes NO, or return to the 
previous dialog panel CANCEL.  

Panel Area

The Panel Area is used to display the dialog 
panels, which allow viewing and editing of the 
field values of host database table records. The 
title bar at the top of the area provides a 
description of the type of data (usually a 
grouping of related fields) to which the dialog 
panel is providing access. The dialog panel 

7 KEYBOARD TIP

Pressing the  key on a dialog panel will 
move to the next panel. Pressing the  key 
on a dialog panel will move to the previous 
panel. The cursor will be set on the first 
available field on the new panel. This allows 
you to move from dialog to dialog without using 
the mouse.

Enter

Esc
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currently displayed is also identified as the 
highlighted item in the Navigation Tree.

Dialog Controls

Each control on a dialog panel represents one or 
more fields of a host database table record.  The 
controls are populated with the record values, 
and enabled or disabled based on the record and 
field level permissions given to the operator 
when the operator's account was created.

• If a single record is selected, the dialog 
controls will display the values for the 
selected record.  Entering a value in a control 
will change the value for the selected record.

• If multiple records are selected, the dialog 
controls will be cleared.  Entering a value in 
a control will change the value for all 
records selected.

Enabling and Disabling of Dialog Controls

When editing a selected record, field data is 
displayed and dialog controls are enabled or 
disabled based on the record and field 
permission of the operator as follows:
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Table 2-1:  Dialog Control States

Record 
Permission

Field 
Permission

Control 
State

Value 
Displayed 

or 
Cleared

None None Disabled Cleared

None View Disabled Cleared

None Update Disabled Cleared

View None Disabled Cleared

View View Disabled Displayed

View Update Disabled Displayed

Update None Disabled Cleared

Update View Disabled Displayed

Update Update Enabled Displayed

Insert None Disabled Cleared

Insert View Disabled Displayed

Insert Update Enabled Displayed

Delete None Disabled Cleared

Delete View Disabled Displayed

Delete Update Enabled Displayed
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Right Popup Menu

Use the right mouse button to display the 
Refresh option. 

Refresh
This will update any of the pull-down lists 
or list controls that are dependent on other 
tables.

Making Changes

Changing a value in a control will mark the 
selected record(s) with the Changed icon . 
Once changes have been made, you are required 
to either Save or undo the changes.  
See "Restore" on page 2.36 for how to undo 
changes.  Some operations such as Search will 
not be available until the changes are saved or 
undone.

The Status Window
The Status Window shows the current status of 
operations performed by the operator. Any 
errors encountered during creation, 
modification, or saving of records to the host 
database are shown here. The Status Window 
also provides direct navigation to records in 
error, allowing an operator to go directly to a 
record with an error by simply double-clicking 
the error message. The Panel Area of the Form 
Window will reflect the operator navigation to 
records with errors. 
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The Status Window, located at the bottom of the 
application main window, is used to indicate 
any conditions that must be resolved before 
saving records to the host database, and to log 
any problems that occurred when saving those 
records.  Status information is listed in the 
Status Window by field name and message.  
Each dialog panel within the Panel Area of the 
Form Window orders messages such that all 
messages pertaining to a single panel are 
displayed together. If the same status 
information applies to more than one record, a 
count will appear in parentheses next to the 
field name.

Records that have errors, which must be 
resolved before saving, are marked with the 
Warning icon  in the grid. Messages resulting 
from saving records will remain displayed until 
the next save operation is performed.

Resolving an Error Message

Clicking on a message in the Status Window 
will bring up the appropriate form in the Panel 
Area of the Form Window. The cursor will be in 
the field on the corresponding dialog panel with 
the error.  It will select the row in the grid of the 
Record List Window to which the message is 
related, fill the dialog panels with the values of 
that record, display the dialog panel with the 
field, and set the cursor focus to the field with 
the message.  Likewise, selecting a row in the 
grid that displays the Warning icon  will 
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similarly set the focus to the first field that has 
an error to be resolved.

Common Error Messages
Required
This is a required field.  Entering a value for 
the field will remove the error message.

Too many characters
Too many characters have been entered into 
an edit field.

Illegal characters
The following are illegal characters and 
must not be entered by operators for field 
values:

*    asterisk

<    less than sign

>    greater than sign

!    exclamation point

=    equal sign

&    ampersand

|    vertical bar

^    carat symbol

'    single quote

"    double quote
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The Record List Window
The Record List window shows the results of 
search operations and allows operators to 
quickly navigate through the records found by a 
search. The data displayed in the Record List 
window consists of one or more fields of the 
host database table that is being manipulated by 
the application. The number and order of the 
fields displayed is completely configurable by 
the operator. When an application is started, the 
Record List window is initially empty. 

The operator uses the Record List window 
mainly for record navigation. A single record or 
multiple records may be selected for 
manipulation. The Panel Area of the Form 
Window will reflect the operator selection.

A typical Access Vision application may 
provide manipulation of several host database 
tables from within the same application. An 
independent Record List is maintained for each 
table although only one such list is displayed at 
a time. 

The Record List window contains a grid that is 
used to display the current set of records the 
operator is working with. Each record is 
represented as a row in the grid. The columns 
display the values of identifying fields in the 
record, such as a description. The operator can 
select which fields are displayed as columns in 
the grid.
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Obtaining Records for the Grid

The grid is filled with records by performing a 
search, by creating a new record, or by cloning a 
record. When a search is performed, the grid is 
filled with all of the records matching the search 
criteria. All previous records that were in the 
grid are removed. When adding new records, 
via New or Clone, the records are placed at the 
bottom of the grid, and are marked with the 
New Record icon . 

Existing records retrieved from a search will 
always display their original values in the grid. 
New records will display the values entered by 
the operator. 

Record Selection (Single Row)

Clicking on a single row in the grid will 
highlight and select that record for editing. The 
keyboard up and down arrows can also be used 
to move from one record to the next. The 
record’s values will appear in the dialog panels 
of the Panel Area of the Form Window for 
editing. Changing a field value will change it 
only for the selected record. If any field value is 
changed, the Edit icon  will appear next to 
the row.
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Record Selection (Multiple row)

Multiple rows can be selected in order to change 
a value for multiple records at one time, for 
example, updating a time value for all records. 
Multiple rows can be selected by left clicking the 
mouse on the first desired record, dragging the 
mouse, and releasing it on the last desired 
record. Non-connected rows may be added to 
the selection by holding down the  key on 
the keyboard while selecting the row with the 
mouse. All selected rows will be highlighted. 
When multiple rows are selected, the dialog 
panels of the Panel Area of the Form Window 
will be cleared. Changing a field value will 
change it for all selected records. If any field 
value is changed, the Edit icon  will appear 
next to the selected rows. 

Ctrl
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Grid Icons

Under certain circumstances, icons will appear 
next to (to the left of) a row in the grid. These 
generally indicate the current status of the 
record:

New This is a new record created by 
either New or Clone.

Deleted The record has been marked 
for deletion.

Edited The record has been changed. 
The changes must be saved or 
restored.

Errors Status errors, such as required 
fields, must be resolved for the 
record. See “The Status 
Window” on page 2.54.

Warning Status warnings are conflicts 
that occurred while saving to 
the host, indicating a change 
was not saved. After resolving 
the conflict, you can save the 
record again. The Warning icon 
stays active until the next save 
or the record is restored.
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Grid Popup Menu

The grid popup menu is available by clicking 
the right mouse button over the grid. The 
available options are:

Refresh
Refresh the rows in the grid.  See “Refresh” 
on page 2.38.

Grid Lines
Turn the grid lines on or off. See “Grid 
Lines” on page 2.36.

Grid Columns
Select the columns and the order in which 
they are to be displayed in the grid. See 
“Grid Columns” on page 2.36. 

Restore
Restore the selected records to their original 
state. See “Restore” on page 2.36.

Select All 
Select all records in the grid.
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NOTES
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Administration

Operators
The Operator application controls the 
operations that an operator can perform and 
the applications in which he can perform them. 
The system administrator, knowing which 
applications the operator is allowed to run and 
the type of access they can have, assigns the 
appropriate permission to the operator. This 
application can be used to:

p Define and edit operator account 
identification. 

p Assign facilities to an operator.

p Define and edit permissions. 

p Assign area permission groups to a 
permission. 

p Assign category permission groups to a 
permission.

p Assign report permission groups to a 
permission. 

p Assign application permissions to a 
permission. 
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Operator Identification
All Picture Perfect operators are able to work in 
Access Vision. Creating a new operator in 
Access Vision will create a new Picture Perfect 
operator and will create a new account for their 
login ID. Editing any of the operator’s fields 
changes them in both Access Vision and Picture 
Perfect. Deleting an operator record does not 
remove the operator’s account for their login ID. 
The login ID, once assigned, cannot be changed. 
When changes are made to the other operator 
attributes on this screen, these changes are 
automatically applied to Picture Perfect. The 
following fields are used to create a new 
operator or edit an existing one:

Login ID:
Login name (1 to 8 lowercase characters) the 
user types to gain access to Access Vision 
and Picture Perfect. This field will be View 
Only unless adding a new operator. 

Employee ID:
Company identification number assigned to 
the person that uses the login ID (1 to 12 
characters).

Name:
Name or description of the person that uses 
the login ID (1 to 40 characters).

Permission:
From the picklist, select the permission to be 
assigned to the operator, for instance, 
System Administrator.
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Host Language:
From the picklist, select the language of the 
host operating system, for instance, English 
in US.

Change Password:
Click on this button to allow the 
administrator to change an existing 
password. 

Create Account:
Click on this button to create or re-create the 
user account associated with this operator. 
This is required to create accounts on a 
backup server in a redundant system, or to 
re-create user accounts after a system 
restore.

NOTE

An operator cannot modify his own assigned 
Permission. This field will be disabled and 
appear “grayed out.”
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To assign a Permission to an operator:

1. Double-click on the Operator icon from 
the Launcher.

2. Click on SEARCH.

3. Select the operator from the list 
displayed on the right.

4. Select a Permission from the drop-down 
list.

5. Click on SAVE.
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Facilities
Once a facility is assigned to an operator, it will 
appear in the Facility Selection screen after a 
successful operator login. The system 
administrator can assign/unassign facilities by 
moving them between the Available Facilities 
list box and the Selected Facilities list box. This 
can be done one of two ways: by highlighting an 
item and selecting ADD or REMOVE, or by double 
clicking on a selected facility.

Available Facilities
Facilities that have not been assigned to the 
operator.

Selected Facilities
Facilities that are assigned to the operator.

Permissions
Use this area to define the operator's 
database access level. Operators assigned a 
Permission will have access to the 
corresponding Area permission groups, 
Category permission groups, Report 
permission groups, and Application 
permissions assigned to that permission. 

Description
Enter a job description of the operators that 
will be assigned this permission (1 to 30 
characters). Example: Badge Administrator.

3_Administration.fm  Page 5  Wednesday, June 7, 2000  12:16 PM



Operators

Access Vision User’s Guide3.6

Area, Category, or Report
Permission Groups 

Areas are groups of logically related readers and 
doors with identical access requirements. A 
permission group is assigned to each area. If an 
operator needs to modify an area or the readers 
and doors assigned to it, that Area permission 
group must be included in the permission 
assigned to that operator.

Categories are groups of people and are 
assigned to areas, readers, and badges. When a 
category on a badge matches a category on the 
area where a reader is assigned, access is 
granted. To restrict the categories an operator 
can issue on a badge or area, Category 
permission groups are included in the 
permission set assigned to that operator. 

SQL reports are assigned permission groups to 
restrict operator report access to only those 
reports included in the operator’s permission 
set. The ability to assign a report to a Report 
permission group also requires that the Report 
permission group be included in the operator’s 
permission set.

NOTE

The Report permission group form will be 
available only if your system is configured to 
use report permissions.
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All groups:
If checked, the permission grants access to 
all permission groups (areas, categories, or 
reports).

Available permission groups:
Up to 20 area or category permission 
groups, or up to 5 report permission groups 
may be selected. Highlight the selection(s) 
and press ADD to add to the Selected 
permission group list. 

Selected permission groups:
Once a permission group has been added 
from the Available permission groups list, it 
will appear in this list box. To delete a 
selection, highlight it and press REMOVE.

Application Permissions
This screen is used to set the applications that an 
operator is able to run, and the level/type of 
permissions the operator will have when 
running the application. The current 
permissions will be displayed in the Assigned 
Permissions list box. Application permissions 
for an application can be added or changed by 
selecting the application from the Application 
drop-down list and then selecting an application 
permission from the Application Permission 
drop-down list. Selecting NONE from the 
Application Permission drop-down list will 
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remove the current permission. An operator can 
only have one permission per application.

Figure 3-1.  Application Permissions

Assigned application permissions:
A list box displaying the currently assigned 
applications and the corresponding 
permissions for the selected operator. The 
operator will be able to run all applications 
listed in the Assigned application 
permissions list box.

Assign application permission:
Application:
Used to select the application to which an 
application permission will be assigned.

The currently assigned 
applications and the 
corresponding permissions 
for the selected operator.

The application to which an 
application permission will be 
assigned.
The application to which an 
application permission will be 
assigned.
The application to which an 
application permission will be 
assigned.

Application permissions for 
an application can be added 
or removed by selecting from 
the Application Permissions
 drop-down list. 
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Application Permission:
Application permissions for an application 
can be added or removed by selecting from 
the Application Permissions drop-down 
list. A permission can have only one 
application permission per application. 

To assign an application permission to a 
permission:

1. Select the Operators icon from the 
Launcher.

2. Select Permissions.

3. Click on SEARCH.

4. Select a Permission from Description 
column from the Record List Window 
on the right.

5. Select Applications from the Navigation 
Tree area.

6. Edit as desired.

7. Click on SAVE.

NOTE

Access Vision Application Permissions only 
affect permissions for the applications in 
Access Vision. They do not control or affect 
any permissions for the X-Windows, Unix, or 
Secure Area Manager™  applications. See the 
Permissions online help in those applications 
for further information.

3_Administration.fm  Page 9  Wednesday, June 7, 2000  12:16 PM



Partitions

Access Vision User’s Guide3.10

Partitions
The Partitions application allows the system to 
be grouped according to facility, permission 
group, or category. It provides a way of defining 
the record and field level access permissions for 
workstation functions. This application is used 
to define:

p Facility records. 

p Area and category permission groups.

p Report permission groups.

p Categories of people who use a facility and 
their associated permission groups.

NOTE

In a network system, facilities, permission 
groups, and categories can only be created on 
a network host, not on a subhost.
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Facility Records
A Facility is a conceptual item, such as a 
building, a floor in a building, or a room on a 
particular floor in a building. A facility record is 
simply a text description that can be referenced 
through other applications and allows access to 
be restricted to specific locations.

To define a facility:

1. Click on the Partitions icon from the 
Launcher.

2. Select Facilities.

3. Enter a unique and specific text 
description (1 to 31 characters).
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Permission Groups

Area and Category Permission Groups

Area and Category permission groups define 
security or access levels for areas (groups of 
logically related readers and doors with 
identical access requirements) and categories 
(groups of people). 

An Area permission group allows an operator to 
assign readers and doors to an area. An area 
permission group usually describes the 
operators who can assign an area to readers and 
doors, such as System Administrator or Security 
Manager.

A Category permission group allows an 
operator to assign categories of people to areas 
and badges. A category permission group 
usually describes the operators who define 
access levels for categories of people, such as 
Badge Issue Operator or Badging 
Administrator.
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To define an area or category permission 
group:

1. Select the Partitions icon from the 
Launcher.

2. Under Permission groups, select Areas 
and categories.

3. Enter a unique and specific text 
description (1 to 30 characters).

4. Click on SAVE.
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Report Permission Groups

Report permission groups define access levels 
for SQL reports. Operator report access is 
restricted to those reports specified in the 
Report permission group in the operator’s 
permission set. 

A Report permission group usually describes 
the reports by type, group, or shift, for example:

• Badge History

• Alarm

• Security

• Shift A 0800 to 1700

To define a report permission group:

1. Select Partitions.

2. Under Permission groups, select 
Reports.

3. Enter a unique and specific text 
description (1 to 30 characters).

4. Click on SAVE.
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Categories
A Category is a group of people who use the 
facility. Each category is associated with a 
permission group that defines access rights for 
that category or group of people. 

Categories usually describe the users by type, 
title, group, or shift, for example: 

• Temporary

• Engineering

• Accounting

• Computer Room 24 hrs

• High Risk

To define a category:

1. Select Partitions.

2. Select Categories.

3. Enter a text description (1 to 30 
characters).

4. From the drop-down list, select the 
permission group to be associated with 
the category.

5. Click on SAVE.
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Permissions
An operator’s access to an application, and what 
he can do in the application are defined by a 
combination of the Permission assigned to the 
operator, and the Application Permissions 
assigned to the permission. This can be 
compared to a key and a keyhole or lock.

Figure 3-2.  Permissions Overview

The Permission is the key to the applications an 
Operator can run; the Application Permission is 
the lock that controls what items can be accessed 
(what the operator can see and do while running 
the application).

In the Permissions application, the navigation 
tree contains a list of all Access Vision 
applications, grouped by the Launcher 
Application Toolbar on which they appear. 
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The top level topics are the names of the 
toolbars. These are used only for organizational 
purposes. Clicking on one will bring up a blank 
dialog panel that is not editable, and toolbar 
operations will be disabled. The sub-topics are 
the names of the applications. Each of these 
controls all the application permissions for its 
application, and the Search and other toolbar 
functions work individually for each sub-topic. 
On the dialog that is displayed for each, you can 
perform the following: 

p Define and edit application permission 
settings. 

p Define and edit field level permission 
settings.

NOTE

Not all applications, such as Monitors, will be 
listed because they do not support options that 
can be individually controlled.

3_Administration.fm  Page 17  Wednesday, June 7, 2000  12:16 PM



Permissions

Access Vision User’s Guide3.18

Application Permission Settings
 Access Vision Desktop applications provide 
the capability to control the operations of a 
Picture Perfect system and to manipulate data 
in the database tables of any of the hosts in the 
system. Providing the capability to access or 
change data must also include the capability to 
limit this access as appropriate. The Access 
Vision Desktop extends the permission 
approach utilized with our popular Secure Area 
Manager (SAM) product and applies it to all 
applications and host database tables.

Access Vision table and field level permissions 
are organized by application. For each 
application, there exists one or more 
Application Permissions. An Application 
Permission defines the field and record level 
access allowed to all host database tables 
maintained by the application. This is the same 
table and field level permission information 
provided by the SAM Facility Profile program, 
but extended to apply to all host database tables 
maintained by the Access Vision application. 
The table and field level application permission 
settings used by Access Vision are independent 
of any settings in SAM or Picture Perfect. 
Access Vision controls only the Win98/NT 
Windows applications, while SAM and Picture 
Perfect control the X-Windows applications.

The Access Vision Desktop installation 
procedure provides two standard application 
permissions for most applications, which should 
be sufficient for most customers. The Full 
Editing application permission allows a user to 
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view and change every field of every table 
maintained by the application. (It is important 
to remember that an application may maintain 
data for several host database tables.) The View 
Only application permission allows a user to 
only view the fields of every table maintained 
by the application. The system administrator 
can create customized application permissions 
or edit existing ones for applications as 
required.

Some Access Vision Desktop applications (for 
example, System Monitor, Alarm Monitor, 
Activity Monitor) present information to the 
operator, but do not maintain any host database 
tables. For these applications, record level 
permissions do not apply and permission sets 
are offered that reflect the capabilities provided 
by the application. For example, the application 
permissions offered in the Alarm Monitor are 
View Only and Purge Alarms.

Description
A description (1 to 30 characters) of the 
actions an operator can perform when 
assigned this Application Permission.

NOTE

Access Vision Application Permissions only 
affect permissions for the applications in 
Access Vision. They do not control or affect 
any permissions for the X-Windows, Unix, or 
SAM applications. See the Permissions online 
help in those applications for further 
information.
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Table access:
Actions included in this section are set using 
Database Table permissions.

Table
Each application has database table(s) 
associated with it and the record level 
permissions created for it. For instance, 
when the Alarms application is selected, the 
tables associated with Alarms will be 
displayed in this list box. Each table can then 
be assigned the following record level 
permissions:

View
Used to determine if the operator will be 
allowed to view a record associated with the 
current table.

Update
Used to determine if the operator will be 
allowed to update a record associated with 
the current table. An operator with Update 
permission automatically has View 
permission.

Insert
Used to determine if the operator will be 
allowed to insert a record associated with 
the current table. An operator with Insert 
permission automatically has View and 
Update permissions.

Delete
Used to determine if the operator will be 
allowed to delete a record associated with 
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the current table. An operator with Delete 
permission automatically has View, Update 
and Insert permissions.

Clicking on a table name, or double clicking on a 
row in the Table access list will bring up the 
Field Access dialog where the field level 
permissions may be set. 

Set all:
Use these push-buttons to quickly set all the 
tables to the same setting. Select None to 
remove all Table Access permissions.

Special Operations
Actions listed in this list box are specific to the 
selected application and can not be set using 
Database Table permissions. Enabling the check 
box next to the operation means that operators 
assigned the Application Permission will be 
allowed to perform that operation. An example 
of the Access Vision Special Operation 
permissions for the Badges application are 
shown below.

NOTE

The delete function may be disabled by the 
application even if the Delete permission is 
granted. Not all host types or tables allow 
deletion of records.
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Figure 3-3.  Special Operations

To create an application permission:

1. Select the Permissions icon from the 
Launcher.

2. Select an application.

3. Search.

4. Click New.

5. Enter Description.

6. Edit Table Access as desired.

7. Click on SAVE.
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To define special operation permissions:

1. Select the Permissions icon from the 
Launcher.

2. Select Permissions.

3. Search.

4. Select a record.

5. Click to select or deselect the Special 
Operations listed for that record.

6. Click on SAVE.
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Field Level Permissions
Application Permissions can be further defined 
to a field level by double clicking on a table row. 
Access can then be granted to specific fields in a 
table. For instance, you may want to restrict the 
View permission on a field such as a password 
or encoded number. 

Figure 3-4.  Application Permission Settings

Table:
The table row that was selected.

Field Permissions list box:
All fields associated with the selected table 
will be displayed. Some check boxes may be 
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disabled based on the table level permission 
that was set. This prevents you from 
overriding the table level permission. 

View
Used to determine if the operator will be 
allowed to view the field. If View is not 
checked, data for that field will not be 
displayed. 

Update
Used to determine if the operator will be 
allowed to update the field. An operator 
with Update permission automatically has 
View permission.

Set All:
Use these push-buttons to quickly set all the 
tables to the same setting. Select None to 
remove all field permissions.

NOTE

In order to search by a particular field, View 
permission must be checked for that field.
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Record and field-level access permissions are 
defined in the tables below. Each increasing 
level of permission access is inclusive of the 
lower levels of access. For example, 
record-insert access also includes record-update 
and record-view access. 

All permission information and permission 
assignments to Access Vision Desktop 
operators are stored in the Picture Perfect host 
database table. They are saved as part of the 
standard host database backup procedure. 

Table 3-1:  Access Vision Record-Level Access 
Permissions

Permission Description

None No access to records of the table

View Can only view data in records of the table

Update Can modify existing records in the table

Insert Can insert new records into the table

Delete Can delete existing records from the table

Table 3-2:  Access Vision Field-Level Access Permissions

Permission Description

None No access to the field. Data will be hidden for the field.

View Can only view data for the field

Update Can modify the field
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To define a field-level permission:

1. Select the Permissions icon from the 
Launcher.

2. Select an application.

3. Perform a Search.

4. Select a record.

5. Double click on a table row.

6. Edit Field Access as desired.

7. Click on SAVE.

NOTE

In redundant Picture Perfect systems, the 
permission information and permission 
assignments are automatically refreshed to the 
backup host whenever changes are made on 
the primary host.

In network Picture Perfect systems, the 
network host and each subhost maintain their 
own independent permission information and 
assignments.
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Setting Up Permissions 
To set up permissions for an operator, follow the 
steps below:

p Create Application Permissions.

The first step in setting up permissions is to 
create the Application Permissions. These 
define what table and field level permission 
settings are available for each application. 
By default, a Full Edit and View Only 
Application Permission is provided for each 
application. If you want to further restrict 
what an operator can do in an application, 
use the Permissions application to create 
new Application Permissions.

p Assign Application Permissions to a 
Permission.
• Using the Operator application, select 

the Permissions dialog panel. 
Permissions are the key to which 
applications can be run. They also 
control which Areas and Categories are 
available for selection from drop-down 
lists.

• Click on the SEARCH button to edit 
existing Permissions, or create new ones.

• Select the Application Permissions 
sub-category to add or remove 
Application Permissions. Adding an 
Application Permission to the list means 
that application’s icon will be visible on 
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the Application Launcher to an operator 
using this permission. Removing it 
means it will not be visible and they will 
not be able to run that application. 

For each application listed in the 
Assigned Application Permissions box, 
the record and field level permissions 
granted will be that of the Application 
Permission selected for that application. 
Use the drop-down lists at the bottom to 
add, remove, or change which 
Applications and Application 
Permissions are listed. 

p Assign a Permission to one or more 
operators.
Each operator has one permission. By 
assigning the operator a permission, you are 
giving him access to everything the 
permission grants them. When the operator 
logs in, the Access Vision system will check 
the permission assigned to that operator and 
determine what he is allowed to do. Only 
those icons for applications that the operator 
can execute will be displayed on the 
Application Launcher toolbars.
You can assign multiple operators the same 
permission, thereby allowing you to set up 
your system once with permissions based on 
job functionality, or some other criteria. 
Then you can simply assign a pre-defined 
permission to each operator. 
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To assign permissions:

Step 1. Create an Application Permission.

1. From the Application Launcher, click on 
the Permissions icon to start the 
Permissions application.

2. Select an application, for example: 
Doors.

3. Click on NEW.

4. Enter a description for the Application 
Permission.

5. In the list labeled Table access, click on 
the desired check box: View, Update, 
Insert, or Delete.

6. Under the Table column, click or 
double-click on a row to bring up the 
Field Permission form.

7. Click on the desired field permission: 
None, View, or Update.

8. Click OK.

9. Click on SAVE.
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Step 2. Assign the Application Permission to a 
Permission.

1. From the Application Launcher, click on 
the Operators icon to run the Operators 
application.

2. Under Operators, click on the 
Permissions category.

3. Click on NEW.

4. Enter a description for the Permission.

5. Click on the Application Permissions 
sub-category.

6. From the Application drop-down list, 
select an application.

7. From the Application permission 
drop-down list, select an application 
permission.

8. Click on SAVE.
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Step 3. Assign the Permission to an Operator.

1. In the Operators application, click on the 
Operators category.

2. Click on SEARCH to retrieve the current 
operators.

3. From the grid, select an operator who 
will use the new permission.

4. From the Permission drop-down list, 
select the new permission.

5. Click on SAVE.
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Reporting
The Reports application provides an interface to 
the Informix-Online Picture Perfect database so 
you can use ANSI standard SQL Select 
statements to query the database and generate 
reports. You may select from predefined 
CASI-RUSCO reports or create your own 
custom reports.

If you are not familiar with SQL, use an SQL 
reference book or select one of the pre-loaded 
reports. 

Use this feature to:

p Open and view an SQL Quick (predefined) 
report. 

p Open and view an existing custom report. 

p Create a custom report. 

NOTE

CASI-RUSCO also provides a training class on 
SQL. Contact the Training Department for 
details.
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SQL Quick Reports
An SQL QReport (Quick Report) is a 
pre-defined report which comes with the Access 
Vision system. When you click SQL QReport on 
the toolbar, the Select Report window will 
display a list of available reports. These reports 
are View Only and only those reports that the 
operator has permission to view will be 
displayed. 

An example of an SQL QReport is shown below.

Figure 3-5.  Example of an SQL QReport

To view a Quick Report:

1. Select Reports.

2. From the toolbar, click SQL QReports.

3. Highlight a report and click on OK.
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Custom Reports

Existing Reports

You can open and view custom reports that 
have been stored on the client PC of your Access 
Vision system. This feature is available only to 
operators assigned a Report permission group 
through the Operator’s application.

When you click Open on the toolbar, or select 
Open from the File menu, a list of existing 
reports with the extension .sql will be 
displayed. It may be necessary to navigate to the 
directory where your reports are stored. In your 
Access Vision program files, the default report 
directory is users/<userID>.

To open and view a custom report:

1. Select the Reports icon from the 
Launcher.

2. From the toolbar, click OPEN.

3. Double click on a filename.sql, 
where filename is the name of the 
desired file.
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New Reports

By interfacing with Picture Perfect, Access 
Vision allows you to select data from all Picture 
Perfect database tables to create a report and 
save that report to your Access Vision Client 
PC. You can build your own SQL statement for a 
new custom report, or you can open an existing 
report, save it under a new title, and modify the 
SQL statement to build a new report.

p Click New from the toolbar, or select New 
from the File menu.

Result: A confirmation dialog will appear to 
allow you to save the current report, if 
necessary. 

p From the Edit menu, select Preferences.

Result: The Preferences dialog will display.

Figure 3-6.  Preferences
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p Enter a meaningful title for your report, for 
example: Alarm Report - A.M. Shift and, if 
desired, include a header and/or footer. 

p Click on OK.

p From the View menu, select Direct SQL.

Result: A blank SQL statement window will 
display.

Figure 3-7.  SQL Statement Window

p Enter your SQL query, for example SELECT 
* FROM alarm. 

p Click on the RUN button.

Result: The new report will be displayed on 
your screen.
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Figure 3-8.  Example of a Custom Report

p From the File menu, select Save or from the 
toolbar, click on SAVE.
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To create a new custom report:

1. Select the Reports icon from the 
Launcher.

2. From the toolbar, click New.

3. From the Edit menu, select Preferences.

4. Enter a title.

5. Click on OK.

6. From the View menu, select Direct SQL.

7. Enter SQL query.

8. Click on Run.

9. Click on SAVE.
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NOTES
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Configuration

Areas
An area may be one contiguous physical space 
(such as the Computer Room) or it may be a 
number of separate but related spaces (such as 
Computer Room, MIS Lab, Computer Vault) 
that require the same level of access control.

Area Configuration
The Area Configuration feature allows the 
operator to group micros, doors, and readers 
having the same access requirements. All of the 
components can then be manipulated by a 
single action. For instance, if an area consisted 
of one micro, four doors, and four readers, all of 
these devices could be put offline by placing the 
area offline. 

This application is used to:

p Configure area details. 

p Set area properties. 

p Set area input groups. 

p Set area routings. 

p Set area categories. 

4_Configuration.fm  Page 1  Wednesday, May 17, 2000  4:54 PM



Areas

Access Vision User’s Guide4.2

Configure Area details

The following fields define the functions and 
features of an area:

Description
A unique physical description of the area 
(1 to 30 characters), such as Research Lab, or 
General Access.

Permission Group
The security level assigned to the area. Only 
operators with this security level assigned to 
their area group will be allowed to add to or 
change readers and doors assigned to this 
area.

Route Definition
Allows the operator to specify a terminal or 
a group of terminals to which the area’s 
activity will be directed. If this field is left 
blank, this area’s activity will be routed to all 
terminals. Route Definitions are stored on 
the Picture Perfect host.

NOTE

In a network system, areas can only be created 
on a sub-host, not on a network host.

NOTE

To assign a Permission Group or a Route 
Definition, they must first be defined.
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To define an area:

1. Select the Areas icon from the Launcher.

2. Select Area Configuration.

3. Enter a text description.

4. Select a Permission Group.

5. Specify a Route definition, if desired.

6. Click on SAVE.
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Set Area Properties

The following fields allow the operator to set the 
controls for the area:

Physical State
Enabled
Allows readers assigned to this area to read 
badges.

Disabled
Readers assigned to this area are not able to 
read badges.

Logical State
Online
Allows readers assigned to this area to open 
doors.

Offline
Readers assigned to this area cannot open 
doors.

Shunting
Enabled
Allows doors with keypads to ignore the 
door open sensor when a shunt code is 
entered.

Disabled
The door open sensor will activate even 
when a shunt code is entered.
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Scheduling
Enabled
Instructs the microcontroller(s) to observe 
schedule events for the area record, such as 
categories, routing, and area online 
schedules.

Disabled
Instructs the microcontroller(s) to ignore 
schedule events for the area record, such as 
categories, routing, and area online 
schedules.

Antipassback Enforcement
Normal
A badge with an APB (antipassback) status 
In will not be granted access through an 
APB IN reader; a badge with an APB status 
Out will not be granted access through an 
APB OUT reader; a violation message is 
generated.

Passive
A badge with an APB (antipassback) status 
In will be granted access through an APB IN 
reader; a badge with an APB status Out will 
be granted access through an APB OUT 
reader; a violation message is generated.
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To set area properties:

1. Select the Areas icon from the Launcher.

2. Under Area Configuration, select 
Properties.

3. Click the radio buttons to select the 
desired properties.

4. Click on SAVE.
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Set Area Input Groups

Select from the following list boxes to assign 
input groups to area transactions:

Invalid
Input group to activate when an invalid 
badge access attempt is detected.

Suspended
Input group to activate when a suspended 
badge access attempt is detected.

Lost
Input group to activate when a lost badge 
access attempt is detected.

Unknown
Input group to activate when an unknown 
badge access attempt is detected.

Antipassback
Input group to activate when an 
antipassback violation access attempt is 
detected.

Duress
Input group to activate when a duress access 
attempt is detected.

NOTE

To assign an input group, it must first be defined.
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To set area input groups:

1. Select the Areas icon from the Launcher.

2. Under Area Configuration, select Input 
groups.

3. Click the down arrow to select the 
desired input groups to be assigned to 
each transaction.

4. Click on SAVE.
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Routing

Select from the following list boxes to set area 
routings. The information in the list boxes is 
obtained from the Picture Perfect routing table 
and determines where the various alarm or 
activity messages will be directed.

Valid routing
Destination of valid badge access messages.

Invalid routing
Destination of invalid badge access 
messages, such as no category match, 
expired, or deleted.

Suspended routing
Destination of access attempts by suspended 
badges.

Lost routing
Destination of access attempts by lost 
badges.

Unknown routing
Destination of access attempts by unknown 
badges.

NOTE

To assign a Route Definition, it must first be 
defined in Picture Perfect.
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Antipassback routing
Destination of normal and passive 
antipassback violation messages.

To set area routings:

1. Select the Areas icon from the Launcher.

2. Under Area Configuration, select 
Routing.

3. Click the down arrow to select the 
destination of an alarm or activity 
message type.

4. Click on SAVE.
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Categories

An area contains a group of readers and doors. 
Categories assigned to the area act as locks. A valid 
badge read occurs if one of the categories on the 
badge matches one of the categories in the area. 

Select from the following list boxes to assign 
categories to an area:

Category 1 - 10
A category assigned to a badge must match a 
category assigned to the reader‘s area to be 
granted access.

To set area categories:

1. Select the Areas icon from the Launcher.

2. Under Area Configuration, select 
Categories.

3. Click the down arrow to assign a category 
to the area.

4. Click on SAVE.

NOTE

To assign a category, it must first be defined.
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Area Event Scheduling
The Area Event Scheduling feature associates 
events to an area allowing you to schedule 
recurrent events, such as maintenance, as well 
as date specific events, such as holidays. Use this 
feature to:

p Schedule area events. 

p Manage door states for an area event. 

p Manage reader states for an area event. 

p Manage reader functionality. 

p Manage routings for area event. 

p Manage area event categories. 
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Schedule Area Events

An area event controls the devices defined to be 
in the area. The following fields define the 
functions and features of an area event:

Description
A unique description of the event (1 to 30 
characters), such as Unlock General Access 
Doors.

Area
The area affected by this event.

Online
Readers assigned to the area may open 
doors.

Offline
Readers assigned to the area may not open 
doors.

Occurs
Day of the Week
The event takes place on the days selected 
in this field.

At mode start
The event takes place whenever the mode 
selected is invoked, either by schedule or 
command.

At mode end
The event takes place whenever the mode 
selected is changed.
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At time
Time when the event takes effect on the days 
selected by pushing the DAY OF THE WEEK 
buttons. 

Mode
The event takes place only when the system 
is in the mode selected.

To define a schedule event:

1. Select the Areas icon from the Launcher.

2. Select Schedule Events.

3. Enter a description.

4. From the drop-down list, select the area 
where the event will occur.

5. Click the appropriate radio button to set 
the readers in the area online or offline 
during the event.

6. Specify when the event is to occur. 

7. Click on SAVE.
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Door state

The following fields allow the operator to 
specify the state of the doors in the area when 
the event occurs:

Door State
Unlocked
Unlock all doors in the area.

Locked
Lock all doors in the area.

Held Open Sensing
Detected
Enable all door Held Open sensing.

Ignored
Disable all door Held Open sensing.

Forced Open Monitoring
Detected
Enable all door Forced Open monitoring.

Ignored
Disable all door Forced Open monitoring.
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To set a door state for a scheduled event:

1. Select the Areas icon from the Launcher.

2. Under Schedule Events, select Door 
state.

3. Click the appropriate radio button to set 
the doors in the area to locked or 
unlocked during the event.

4. Click the appropriate radio buttons to 
enable or disable other door features.

5. Click on SAVE.
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Reader state

The following fields allow the operator to 
specify the state of the readers that are assigned 
to this area:

Reader Status
Online
Individual readers may open doors.

Offline
Individual readers may not open doors.

Number of badge reads required
Single
Single badge read required for door strike 
activation.

Double
Double badge read required for door strike 
activation. A double badge read requires 
two complete, valid, and distinct 
transactions.

Physical reader type
Badge only
Reader configured as a badge reader. A 
valid badge read is required for door strike 
activation.

Badge and keypad
Reader configured as a badge and keypad 
reader. A valid badge read and a valid 

4_Configuration.fm  Page 17  Wednesday, May 17, 2000  4:54 PM



Areas

Access Vision User’s Guide4.18

keypad entry is required for door strike 
activation.

Keypad only
Reader configured as a keypad reader. A 
valid keypad entry is required for door 
strike activation.

Badge or keypad
Reader configured as a badge or a keypad 
reader. A valid badge read or a valid keypad 
entry will activate the door strike.

Swipe and show control
Enabled
Reader configured with Swipe and Show 
function. A valid badge swipe results in a 
photo associated with the badge being 
displayed on the Activity Monitor. 

Disabled
Reader not configured with the Swipe and 
Show function.

Authorization required
Yes
The photo of the badgeholder is displayed 
and access is allowed only through operator 
action.

+ If a reader is 
defined as Toggle, 
this feature cannot 
be enabled.

NOTE

Access cannot be granted through a reader 
defined as  Authorization required while 
communications to the micro are down.
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No
The photo of the badgeholder is displayed 
and access is allowed without any operator 
intervention.

To set a reader state for a scheduled 
event:

1. Select the Areas icon from the Launcher.

2. Under Schedule Events, select Reader 
state.

3. Click the appropriate radio button to set 
the status of the readers during the 
event.

4. Click the appropriate radio buttons to 
enable or disable other reader features.

5. Click on SAVE.
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Reader Function

Select from the following list boxes to specify 
the function of readers defined to an area.

Logical reader function
Normal
Used to grant access into an area.
Antipassback in
Used to log a badgeholder IN when 
entering. A badge already having an APB 
status of IN will not be granted access.
Antipassback out
Used to log a badgeholder OUT when 
exiting. A badge already having an APB 
status of OUT will not be granted access.
Time and attendance in / out
Used to log a badgeholder IN and OUT at 
the start and end of a work shift, using the 
same reader by swiping the card the normal 
way for IN and reversing the card or turning 
the card backwards for OUT.
Time and attendance in
Used to log a badgeholder IN at the start of a 
work shift. A badge already having a Time 
and attendance IN status will not be granted 
access.
Time and attendance out
Used to log a badgeholder OUT at the end of 
a work shift. A badge already having Time 
and attendance OUT status will not be 
granted access.
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Antipassback type
These fields will only be available for 
configuration if the logical reader function is 
set to Antipassback in or Antipassback out.

Global APB
The APB status of a badge on a micro will 
not change unless the badge is used on an 
APB reader. 

Timed APB
Causes the APB status to be set to either IN 
or OUT and will return to NEUTRAL after a 
defined period of time. Timed APB is a 
feature that is local to the micro.

Reset Timed APB immediately
Toggling this button is equivalent to 
selecting a Timed APB Duration of 0 and 
resets the Timed APB status back to 
NEUTRAL immediately following a badge 
swipe.

Timed APB duration
Enter a value to represent how long a 
badgeholder‘s Timed APB status will be set 
when his badge is used on the reader. The 
Timed APB Duration cannot exceed one 
day. A duration of 0 allows the micro to 

NOTE

If this option is selected, a Timed APB Duration 
must also be defined.
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reset the status to Neutral immediately, 
producing the same effect as Reset Timed 
APB immediately.

To set a reader function for a scheduled 
event:

1. Select the Areas icon from the Launcher.

2. Under Schedule Events, select Reader 
function.

3. Click the appropriate radio button to set 
the logical reader functions of the 
readers during the event.

4. If Antipassback IN or OUT was selected, 
click the appropriate radio buttons to 
select the antipassback type.

5. Click on SAVE.
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Routing
Select from the following list boxes to assign 
routings to area events. The information in 
the list boxes is obtained from the Picture 
Perfect routing table.

Valid routing
Destination of valid badge access messages.

Invalid routing
Destination of invalid badge access 
messages, such as no category match, 
expired, or deleted.

Suspended routing
Destination of access attempts by suspended 
badges.

Lost routing
Destination of access attempts by lost 
badges.

Unknown routing
Destination of access attempts by unknown 
badges.

NOTE

To assign a Route Definition, it must first be 
defined.
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Antipassback routing
Destination of normal and passive 
antipassback violation messages.

To set routings for area events:

1. Select the Areas icon from the Launcher.

2. Under Scheduled Events, select Routing.

3. Click the down arrow to select the 
destination of an alarm or activity 
message type.

4. Click on SAVE.
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Categories

An area contains a group of readers and doors. 
Categories assigned to the area act as locks. A 
valid badge read occurs if one of the categories 
on the badge matches one of the categories in 
the area. 

Select from the following list boxes to assign 
categories to an area event:

Category 1 - 10
Change categories that grant access through 
readers/doors assigned to the area. This is 
done positionally, so a category given in the 
First position only changes the category in 
the Cat1 position on the door record in the 
micro. Any category positions left blank 
retain the previous category assigned to it.

To set area event categories:

1. Select the Areas icon from the Launcher.

2. Under Schedule Events, select 
Categories.

3. Click the down arrow to assign a 
category to the area event.

4. Click on SAVE.

NOTE

To assign a category, it must first be defined.
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Alarms
Alarms are used to notify an operator of an 
exceptional condition by displaying them on 
one or more monitors. The alarm display can be 
configured to include what caused the alarm, 
the action required, the alarm priority, the way 
it looks on the screen, as well as to which 
terminals it will be sent.

Use the Alarm application to:

p Configure alarm details.

p Define the colors that will be used in the 
alarm monitor so that the color scheme 
reflects the alarm state.

p Set alarm properties.

p Set alarm instructions.

p Schedule alarm events.

p Define alarm instructions. 

p Define alarm responses.
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Configure Alarm Details
The following fields define the functions and 
features of an alarm:

Description
A unique description of the alarm, reflecting 
the exception condition being reported by 
the alarm (1 to 30 characters).

Route Definition
A description (1 to 30 characters) of the 
X-Terminals to which the alarm is routed. If 
this field is left blank, this alarm will be 
routed to all X-Terminals. Route definitions 
are ignored by Access Vision, so the alarm 
will always appear in the Alarm Monitor.

Alarm Routing
The device or file to which an alarm message 
is sent. It can include Monitor, Printer, 
History or any combination; however, 
Monitor must always be included in the 
Alarm Routing in order for the operator to 
view the display and respond to the alarm.

Alarm Priority
Used for sorting alarms on the alarm 
monitor; the lower the number, the higher 
the priority and the closer to the top of the 
alarm monitor it displays (0 to 500). The 
priority can either be set by manually 
entering a number or using the Alarm 
Priority slider.
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Alarm color selection
Allows individual alarm colors to be set 
either by entering the color number (0 to 
127), or by selecting from a color chart.

Foreground
In this box, enter the color number (0 to 127) 
that represents the desired text color for the 
alarm message. A sample will be reflected in 
the Color Test box. 

Background
In this box, enter the color number (0 to 127) 
that represents the desired background color 
for the alarm message. A sample will be 
reflected in the Color Test box.

Color Test
A sample of the color scheme, as selected in 
Foreground and Background, will be 
displayed in this box.

Color Table
Pressing this button displays a Color 
Selection window from which you may 
select the color scheme for the alarm 
message. Click in the Foreground or 
Background box and then left click on a color 
from the Color Selector. This will 
automatically update the Foreground or 
Background box with the corresponding 
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color number as well as display the selected 
color scheme in the Color Test box.

Figure 4-1.  Color Chooser
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Alarm Details Process State Option

It is possible to define the colors that will be 
used in the alarm monitor so that the color 
scheme reflects the alarm state. Each alarm in 
the alarm monitor will have a foreground and 
background color (value range of 0 to 127) based 
on its processing state and logical state. This 
option will be used if the Alarm Monitor color 
scheme on the host is set to Processing State. For 
information on selecting this option on the host, 
refer to the PICTURE PERFECT ADMINISTRATION 
GUIDE, Initial Setup.

The following fields define the functions and 
features of an alarm when using this option:

Description
A unique description of the alarm, reflecting 
the exception condition being reported by 
the alarm (1 to 30 characters).

Route Definition
A description (1 to 30 characters) of the 
destination of the alarm routing. If this field 
is left blank, this alarm will be routed to all 
terminals. This description typically refers to 
a portion of your site, such as Building A. 
For example, an alarm with an Alarm 
Routing of Monitor and Printer would go to 
all monitors and printers at your site unless 
it included a Route Definition to a specific 
area of the site.
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Alarm Routing
The device or file to which an alarm message 
is sent. It can include Monitor, Printer, 
History or any combination; however, 
Monitor must always be included in the 
alarm routing in order for the operator to 
view the display and respond to the alarm.

Alarm Priority
Used for sorting alarms on the alarm 
monitor; the lower the number, the higher 
the priority and the closer to the top of the 
alarm monitor it displays (0 to 500). The 
priority can either be set by manually 
entering a number or using the Alarm 
Priority slider.

Alarm colors
Press this button to display the Alarm 
process state color chooser.

Figure 4-2.  Alarm Process State Color Chooser
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To configure alarm details:

1. Select the Alarm icon from the Launcher.

2. Enter a description of the alarm 
condition.

3. Select an Alarm Routing (optional).

4. Set the Alarm Priority.

5. Define the Alarm Colors.

6. Click on SAVE.
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Set Alarm Properties

The following fields define how an alarm 
controls the various devices associated with it:

Alarm online
The alarm may be triggered when an 
associated input group is activated.

Inhibit schedule changes
The microcontrollers ignore any schedule 
events entered for this alarm.

Immediate reset input
Allows the alarm to be removed while in the 
alarm state. Select this option for alarms 
(usually logical alarms) that have no 
set/reset states.

Immediate dial required
Used with dial-up micros only. The 
microcontroller dials the host as soon as it 
triggers the alarm.

Auto reset outputs
Outputs that are triggered by the same input 
group that triggered the alarm are reset 
automatically when the input group resets.

Manual reset outputs
Outputs that are triggered by the same input 
group that triggered the alarm must be reset 
manually when responding to the alarm.
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Duration reset outputs
Outputs that are triggered by the same input 
group that triggered the alarm reset 
according to the duration (in seconds) set on 
the Output’s configuration record.

To set alarm properties:

1. Select the Alarm icon from the Launcher.

2. Under Alarms, select Properties.

3. Click the radio buttons to select the 
desired properties.

4. Click on SAVE.
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Set Alarm Instructions

Alarm instructions can be defined to tell the 
operator what action to take when responding 
to the alarm. 

Available Instructions
Up to five alarm instructions from this list 
may be selected. Highlight the selection and 
click on ADD to add to the Selected Alarm 
Instructions list.

Selected Instructions (select up to 5)
Once an alarm instruction has been added 
from the Available Instructions list, it will 
appear in this list box. To delete a selection, 
highlight it and click on REMOVE.

To set alarm instructions:

1. Select the Alarm icon from the Launcher.

2. Click on SEARCH.

3. Select an alarm from the list on the right.

4. Under Alarms, select Instructions.

5. From the Available Instructions, select 
up to five.

6. Click on SAVE.
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Schedule Alarm Events
An alarm schedule may be defined to 
describe an event that is to occur in 
connection with an alarm. When you want 
to change the characteristics of a single 
alarm without changing the input group or 
output group assigned to the alarm, use an 
alarm event.

The following fields define the functions and 
features of an alarm schedule:

Description
A unique description of the reason for the 
event, such as Disable Main Held Open 
Alarm or Back Door Held Open Print.

Alarm
The alarm affected by this event.

Alarm Routing
Select the routing for the alarm message 
during the event. You can choose from the 
Alarm Monitor, a printer, the history log, or 
a combination of the three. 

Online
Set an alarm Online when scheduling an 
event to occur when the system is in a mode 
other than Normal.

Offline
Set an alarm Offline when scheduling an 
event to occur when the system is in Normal 
mode to ensure that normal activity does not 
trigger an alarm. 
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Occurs
Days of the Week
The days of the week that the event will occur.

At mode start
If selected, the event will take place whenever 
the mode selected is invoked, either by 
schedule or command.

At mode end
If selected, the event will take place whenever 
the mode selected is changed.

At Time
Enter the time when the event takes effect on 
the days selected. 

Mode
The event takes place only when the system is 
in the mode selected.
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To schedule an alarm event:

1. Select the Alarm icon from the Launcher.

2. Select Schedule events.

3. Enter a description of the event.

4. From the drop-down list, select the 
alarm to be associated with the event.

5. Click the appropriate radio button to set 
the alarm online or offline during the 
event.

6. Specify when the event is to occur. 

7. Click on SAVE.
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Define Alarm Instructions
The Define Instructions dialog allows you to 
create a new instruction to be available for 
selection when setting up alarm instructions. 
See “Set Alarm Instructions” on page 4.35.

To define an alarm instruction:

1. Select the Alarm icon from the Launcher.

2. Select Define Instructions.

3. From the toolbar, click on New.

4. In the Instruction text box, type the 
instruction as you want it to appear. 
(Call 911, for example.)

5. Click on SAVE.

6. Repeat steps 1 through 5 to enter 
additional new instructions. 

To view existing instructions:

1. Click on SEARCH to display a list of 
existing instructions.

CAUTION

If you fail to click on New for an additional 
instruction, you will overwrite the previously saved 
entry.
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Define Alarm Responses
The Define Responses dialog allows you to 
create a new response to be available for 
selection on the Alarm Monitor. 

To define a new response:

1. Click on New to enter a new item.

2. Enter the desired text to be displayed. 
(Called 911, for example.)

3. Click on SAVE to save your entry. The 
next time the Alarm Monitor is accessed, 
the new response will be available from 
the Select response from list picklist.

4. Repeat steps 1 through 3 to enter 
additional new responses. 

To view existing responses:

1. Click on SEARCH to search for a list of 
existing responses.

CAUTION

If you fail to click on New for an additional 
instruction, you will overwrite the previously saved 
entry.
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Modes
A mode defines the operating characteristics of 
a facility. The Picture Perfect system supports 
multiple modes of operation, such as Normal, 
Holiday, Emergency, or Fire. For each mode, 
Picture Perfect will control its devices such as 
reader and doors in a predefined way. For 
example, a facility put in Fire mode may cause 
all doors to be unlocked. When a mode becomes 
active, it remains active until changed by an 
operator (Commanded Mode Change) or by a 
scheduled mode event (Scheduled Mode 
Change). 

Commanded operating mode changes can be 
initiated by the operator at any time. Emergency 
and Fire are examples of commanded mode 
changes where an immediate change to a 
different operating strategy is required.

Scheduled operating modes are predefined in 
your system. Normal and Holiday are examples 
of scheduled modes. Schedules are 24 hour, 7 
day events and are assigned to the mode. The 
modes themselves can be scheduled, for 
example, one schedule to enter Holiday mode 
and another for returning to Normal.

This feature may be used to:

p Configure mode details. 

p Schedule mode events. 

p Change the mode of selected facilities.
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Configure Mode Details
The Normal and Holiday scheduled operating 
modes are pre-assigned in your Picture Perfect 
system. Normal represents the normal, 
everyday operating mode of the system. 
Holiday represents the operating mode for 
special days in which the working schedule is 
different from the Normal mode. To create 
additional modes all that is required is the 
following: 

Description
A description of the operating mode (1 to 30 
characters). 

To define a Mode:

1. Click the Modes icon from the Launcher.

2. Enter a description of the operating 
mode.

3. Click on SAVE.
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Schedule Mode Events
A mode event is a scheduled change to one or 
more of the operating conditions. An event can 
be scheduled to cycle within a mode and can 
occur at a particular time on any day(s) of the 
week, usually within a Normal mode, or it may 
take place only once, either at mode start or at 
mode end, as in an Emergency or Holiday mode.

The following fields are used to schedule 
automatic mode changes:

Description
The name of the mode event that is being 
created. This may include the reason for the 
mode change, such as Entering New Years 
Holiday, or Returning after New Years 
(1 to 30 characters).

New mode date
The date when the event takes place, for 
example, 12/31/98. 

New mode time
The time of day when the event takes place, 
for example, 05:00:00 PM. 

New mode
The mode to switch to when the event takes 
place, for example, Holiday. 

Facility
The facility that will have its mode changed 
when the event takes place.
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To schedule a mode event:

1. Select the Modes icon from the Launcher.

2. Select Schedule Events.

3. Enter a description of the mode event.

4. Enter the time period when this change 
will begin.

5. Select the new mode to invoke when the 
mode event occurs.

6. Select the Facility where the mode event 
is to occur. 

7. Click on SAVE.
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Change Mode of Selected Facility
The Mode Change feature allows the operator to 
change the mode immediately for any of the 
available facilities.

Facility
The facility whose mode is to be changed.

Mode
The new mode to enact at the selected 
facility. This control will not be enabled 
unless the current operator has the 
Immediate Mode Change permission.

Permit scheduled mode changes
Yes
Allows future mode changes to occur as 
scheduled by mode events. 
No
Allows the operator to override scheduled 
mode changes in an emergency.
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To change the mode of a selected 
facility:

1. Click the Modes icon from the Launcher.

2. Select Facility mode change.

3. Select a facility.

4. Select the new mode to be enacted.

5. Specify if previously scheduled mode 
changes are to occur.

6. Click on SAVE.
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Devices

Doors
The Door Configuration and Scheduling feature 
allows the operator to add, delete, or modify 
doors in the system and set different 
characteristics for each door as well as schedule 
door events. 

This feature is used to:

p Configure door details. 

p Set door properties.

p Set door inputs and input groups. 

p Set advanced properties.

p Schedule door events.

NOTE

In a network system, doors can only be created 
on a sub-host, not on a network host.

5_devices.fm  Page 1  Wednesday, May 17, 2000  4:55 PM



Doors

Access Vision User’s Guide5.2

Configure Door Details
The following fields define the functions and 
features of a door:

Description
A unique description (1 to 30 characters) that 
identifies the door.

Unlock time (seconds)
The number of seconds the door strike 
remains unlocked. This value should be the 
same as the door strike output Duration 
time, as specified in the I-O Groups 
application, Outputs form.

Forced open shunt time (seconds)
The number of seconds the Door Forced 
Open alarm is shunted. The value entered 
must be equal to the selected unlock time 
plus the additional time needed to shunt the 
Forced Open Alarms after the unlock timer 
has expired.

Allowable open time (seconds)
The number of seconds the Door Open 
sensor is ignored (shunted) on a valid badge 
read.

Keypad shunt time (minutes)
The number of minutes the Door Open 
sensor is ignored (shunted) when a shunt 
code is entered on a keypad.
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Door‘s area
A drop-down list from which you may 
select an area to associate to the door. Only 
operators with the permission group 
assigned to this door‘s area will be allowed 
to update this door.

Strike output
A drop-down list from which you may 
select an output to associate with this door. 
The strike output is a digital output (DO) 
point configured to control the door lock.

Facility
Assigning a door to a particular facility will 
allow you to group or assign doors by 
facility. The facility can then be assigned to a 
facility operator based on that operator‘s 
profiles. 

To define a door:

1. Select the Doors icon from the Launcher.

2. Specify the amount of time the various 
door features are to be active.

3. Assign the door to an Area, Outputs, 
and a Facility.

4. Click on SAVE.
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Set Door Properties
The following fields are used to set the door 
control settings:

Door state
Locked
The door is normally locked.

Unlocked
The door is normally unlocked.

Door strike relock
This feature incorporates the ability to relock 
the door upon a door opening or closing, or 
after a specified period of time. Use the 
following fields to specify your preferences:

On door open
When the door is opened, the door strike 
will relock. Do not use this option if you are 
using magnetic locks with built-in door open 
sensors.

On door closed
When the door is closed (after being open), 
the door strike will immediately relock.

On door unlock duration
The door strike will relock after the Unlock 
Time has expired.
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Options:
Enable scheduling
Schedules for this door will take place.

Detect held open
Door will report a Door Held Open Too 
Long alarm.

Detect forced open
Door will report a Door Forced Open alarm.

Allow exit button asserts strike
The exit button will unlock this door for the 
number of seconds in the Unlock Time field 
and remain open for the number of seconds 
in the Allowable Open Time field.

Allow pre-alarm
The door will report a warning signal before 
the Door Held Open Too Long alarm is 
issued.

Allow keypad alarm response
A Held Open or Forced Open alarm on this 
door can only be reset with a keypad alarm 
response performed at the door’s location.

Allow forced relock
Locks a door if a second person has 
presented their badge to the reader before 
the first person has opened the door.
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To set door properties:

1. Select the Doors icon from the Launcher.

2. Under Doors, select Properties.

3. Click on SEARCH.

4. Select one or more doors from the list on 
the right.

5. Select the various control settings and 
options by clicking the appropriate radio 
buttons.

6. Click on SAVE.
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Set Door Inputs and Input Groups
This feature allows you to assign inputs and 
input groups for the various door transactions. 
The input or input groups can be selected from 
the drop-down list associated with each option.

Door sensor input
The digital input (DI) configured as the door 
sensor.

Exit button input
The digital input (DI) configured as the 
exit/egress button when Exit Button 
Asserts Strike is enabled.

Forced open input group
With Monitoring enabled, the input group 
that is triggered when the sensor reports 
open without a valid open from the 
microcontroller.

Held open input group
With Sensing enabled, the input group that 
is triggered when the sensor reports that the 
door has been open longer than the 
allowable open time.

NOTE

The input groups must be defined before they can 
be assigned to the door.
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Pre-alarm input group
With Pre-Alarm enabled, the input group 
that is triggered when the microcontroller 
reports that within 60 seconds an Open Too 
Long message will be issued.

To assign door inputs and input groups:

1. Select the Doors icon from the Launcher.

2. Under Doors, select Inputs and input 
groups.

3. Click on SEARCH.

4. Select one or more doors from the list on 
the right.

5. Select the various control settings and 
options by selecting from the 
appropriate drop-down lists.

6. Click on SAVE.
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Set Advanced Properties
This feature is available to operators with the 
Special Operations permission, Unlock Doors, 
which is enabled through the Permissions 
application. It allows an operator to unlock a 
door for a specified time.

Unlock Duration (seconds):
The time in seconds that the door(s) will 
remain unlocked.

Unlock
Press to unlock the selected doors, when the 
door state property is Locked.

Lock 
Press to lock the selected door(s), when the 
door state property is Unlocked.

NOTE

If this value is set to Zero (0), the door state will 
remain Unlocked indefinitely.
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To set advanced door properties:

1. Select the Doors icon from the Launcher.

2. Under Doors, select Advanced.

3. Click on SEARCH.

4. Select one or more doors from the list on 
the right.

5. Enter the length of time the door(s) 
should remain unlocked.

6. Click on the UNLOCK button.
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Door Schedule Events
An event takes place at a scheduled time. A 
door event controls the components defined in 
the door. The following fields are used to 
schedule a door event:

Description
A unique description (1 to 30 characters) 
that identifies the reason for the event, such 
as Unlock Main Lobby Door or Disable 
Sensing On Shipping.

Door
The door affected by this event.

Door state
Locked 
Lock the door for this event.

Unlocked
Unlock the door for this event.

Detect held open
Allows an alarm condition on this door to 
occur immediately when the door is held 
open longer than the allowable open time.

Detect forced open
Allows an alarm condition on this door to 
occur immediately when the door is forced 
open without a valid badge read or exit 
device. 
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Occurs
Day of the Week
Days selected when the event takes place.
At mode start
The event takes place whenever the mode 
selected is invoked, either by schedule or 
command.
At mode end
The event takes place whenever the mode 
selected is changed.
At time
Time when the event takes effect on the days 
selected. 
Mode
The event takes place only when the system 
is in the mode selected.
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To schedule a door event:

1. Select the Doors icon from the Launcher.

2. Select Schedule Events.

3. Enter a description of the event.

4. From the drop-down list, select the door 
to be associated with the event.

5. Click the appropriate radio button to 
lock or unlock the door during the event. 

6. Specify settings for alarm conditions by 
clicking the appropriate radio buttons.

7. Specify when the event is to occur.

8. Click on SAVE.
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Input/Output Groups
The Picture Perfect system monitors digital 
inputs (DIs) for contacts and drives digital 
outputs (DOs) for controlling output devices. 
Inputs may be physical connections to a 
microcontroller (micro) or logical events, such as 
a transaction buffer overflow or an invalid 
access attempt. Outputs can operate devices, 
such as door strikes, bells, and lights. Input 
Groups trigger Output Groups when the system 
detects the inputs as “true.”

Use this application to:

p Configure output group details.

p Configure output details. 

p Schedule output group events. 

p Configure input group details. 

p Configure input details. 

p Schedule input group events. 

p Set associated output groups for input group 
events.

NOTE

In a network environment, Inputs, Outputs, and 
Output groups can only be created on a 
sub-host, not on a network host.

5_devices.fm  Page 14  Wednesday, May 17, 2000  4:55 PM



Devices

Access Vision User’s Guide 5.15

5

Configure Output Group Details
When an output group triggers, all outputs 
assigned to the group activate. (An input group 
triggers one or more output groups.) Outputs 
are linked together by assigning the same 
output group to each output.

The following fields are used to define an 
output group:

Description
A description of the output group, including 
a wiring address and a description of its 
functions or effects, such as Fire Output 
Device (1 to 30 characters).

Facility
The facility to which the output group is to 
be associated. Assigning output groups to a 
particular facility will allow you to group or 
assign them by facility. The facility can then 
be assigned to a facility operator based on 
that operator’s profiles.

Enable output group
If selected, the output group can trigger 
outputs assigned to the group.

NOTE

An Output cannot belong to more than one output 
group.
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To define an output group:

1. Select the I-O Groups icon from the 
Launcher.

2. Enter a physical description of the 
output group.

3. Assign the output group to a Facility.

4. Specify whether the output group can 
trigger the associated outputs.

5. Click on SAVE.
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Configure Output Details
Physical outputs that operate devices, such as 
door strikes, lights, or sirens, must be described 
to the system. The description should include 
where this output point is connected, how it is 
wired to activate, how long it remains on when 
activated, how it resets, and what output group 
is associated with it.

The following fields are used to define an 
output:

Description
A physical description of the output, 
including a wiring address and/or a 
description of the location or purpose of the 
output (0 to 30 characters).

Facility
The facility to which the output is to be 
associated. Assigning outputs to a particular 
facility will allow you to group or assign 
them by facility. The facility can then be 
assigned to a facility operator based on that 
operator’s profiles.

Micro ID
The microcontroller to which the output is 
wired. This ID depends on hardware 
switches.

Output group
The output group that triggers the output.
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Board
The logical board number where the output 
is physically wired. The micro’s CPU board 
is always 0 (zero). The board number is 
dependent on hardware switches and 
configuration.

Address
The physical wiring position. This field 
indicates where the output is wired to the 
connector on the board.

Duration
The number of seconds this output remains 
on when activated if Reset on Duration is 
selected. The maximum value is 32,767. If 0 
(zero) is selected, the output will not reset 
but will remain activated continuously.

Enable output
If selected, the output will be activated when 
its output group triggers.

Normally open
The inactive state of the contacts as wired is 
Open.

Reset on duration
If selected, the output will reset after the 
number of seconds specified in the Duration 
field.

Reset on input
If selected, the output will reset as soon as 
the input resets.
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To define an output:

1. Select the I-O Groups icon from the 
Launcher.

2. Select Outputs.

3. Enter a physical description of the 
Output.

4. Assign the Output to a Facility, if 
desired.

5. Specify the wiring details, such as Micro 
ID, Board number, and Address.

6. Specify the output group, if any, that 
triggers the output and if the output will 
be activated.

7. Specify Reset properties.

8. Specify if the inactive state of the output 
is Normally Open.

9. Click on SAVE.

NOTE

If neither Reset on duration nor Reset on 
input is selected, the output stays on. If Reset 
on input is selected, the door does not unlock 
with a valid badge read.
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Schedule Output Group Events
Output group schedules describe an event that 
is scheduled to occur at a specific time on any 
number of days during the week (Runtime) or 
once at the start or end of a mode (Start/End). 
An output group event can enable or disable a 
specific output group, and/or change its state to 
Off or On. The schedule includes a description 
of the event, the output group that the event is 
scheduled for and information about when the 
event is scheduled to occur. 

The following fields are used to describe an 
output group schedule:

Description:
A description (1 to 30 characters) of the 
purpose of the event, such as Turn on 
Parking Lot Lights or Disable Access Bells.

Output group:
The output group affected by this event.

Enable output group
If selected, all outputs in the group will be 
enabled during the schedule. Deselect this 
option to disable all outputs in the group 
during that time period. For example, an 
output group made up of entry-way lights 
that are activated by a motion detector could 
be disabled during daylight hours.
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On state
If selected, the output state of all outputs in 
the group will be On.

Occurs
Day of the Week
The event takes place on the days selected in 
this field.

At mode start
The event takes place whenever the mode 
selected is invoked, either by schedule or 
command.

At mode end
The event takes place whenever the mode 
selected is changed.

At time
Time when the event takes effect on the days 
selected.

Mode
The event takes place only when the system 
is in the mode selected. Normal and Holiday 
modes are already entered into the system 
and additional modes can be created as 
necessary. Normal mode does not usually 
require any start/end events to be 
scheduled. 
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To define an output group event:

1. Select the I-O Groups icon from the 
Launcher.

2. Select Schedule output group events.

3. Enter a description of the output group 
event.

4. Assign the output group event to an 
output group.

5. Specify whether the output group event 
can trigger the associated output group.

6. Specify if the state of the outputs in the 
group is On.

7. Specify the details of when the event will 
occur.

8. Click on SAVE.

5_devices.fm  Page 22  Wednesday, May 17, 2000  4:55 PM



Devices

Access Vision User’s Guide 5.23

5

Configure Input Group Details
Inputs are assigned to input groups. Input 
groups trigger output groups when all or any of 
the inputs assigned to the group are detected. 
Input groups are needed for physical inputs, 
such as readers and sensors, and for logical 
events determined by the system or micro.

The following fields are used to define an input 
group:

Description
A description of the purpose of the input 
group (1 to 30 characters).

Facility
The facility to which the input group is to be 
associated. Assigning inputs to a particular 
facility will allow you to group or assign 
them by facility. The facility can then be 
assigned to a facility operator based on that 
operator’s profiles.

Alarm
The alarm, if any, associated with this input 
group.

Delay time
The number of seconds between the time the 
input(s) assigned to the group are detected 
as true (On state or Change state) and the 
time the input group triggers the alarm 
and/or output group(s) assigned to it. This 
delay helps avoid false input detection.
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Enable input group
If selected, the input group can trigger the 
alarm and/or output group(s) assigned to it.

Detect open condition 
Associated outputs are triggered when an 
open condition state change is detected.

Detect short condition 
Associated outputs are activated when a 
short condition state change is detected.

Broadcast state changes
If selected, any input state changes in this 
input group will be broadcast to all micros 
on the system thus enabling outputs to be 
triggered on other micros. This also has the 
effect, however, of greatly increasing 
system-wide message traffic.

Trigger On:
Any
If selected, the input group will change state 
when any of its inputs are activated.

NOTES

1. The Off to On Delay Time and On to Off 
Delay Time set on an input, overrides the 
Delay Time set on an input group.

2. Set the Delay Time to 0 (zero) for any input 
group assigned to an exit push-button.
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All
If selected, the input group will change state 
only when all of its inputs are activated.

Individual
If selected, the input group will send a 
message to its output group that one of its 
inputs has changed state. Logical alarms 
must always use Individual.

To define an input group:

1. Select the I-O Groups icon from the 
Launcher.

2. Select Input Groups.

3. Enter a physical description of the input 
group.

4. Assign the input group to a Facility.

5. Specify the alarm, if any, associated with 
the input group.

6. Specify the Input states that can trigger 
an output group.

7. Specify the conditions necessary for the 
input group to change state.

8. Click on SAVE.
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Set Parent Input Group Associated
With This Input Group

Each input group can have up to three input 
groups as its parents, and each input group can 
be the parent of any number of input groups, 
thereby creating a tree-like hierarchy of input 
groups. This type of relationship between input 
groups is useful when it is necessary to associate 
more than one type of activity with an input 
group. (For example, an area is equipped with 
motion detectors but the area is patrolled 
periodically. The motion detector input group 
activates alarms but another input group 
suppresses those alarms during the patrol. The 
two input groups are related to the same parent 
input group.)

All inputs in any given group or hierarchy must 
be associated with the same micro. An input 
group that is connected to a parent input group 
becomes an input of that parent input group and 
inherits the parent’s settings. An input group 
cannot be its own parent.

To designate an input group as a parent input 
group:

Available parent input groups
Up to three input groups from this list may 
be selected as parents. Highlight the 
selection and click on ADD to add to the 
Selected Parent Input Groups list.

5_devices.fm  Page 26  Wednesday, May 17, 2000  4:55 PM



Devices

Access Vision User’s Guide 5.27

5

Selected parent input groups (up to 3)
Once an input group has been added from 
the Available Input Groups list, it will 
appear in this list box. To delete a selection, 
highlight it and click on REMOVE.

To associate a parent input group with 
an input group:

1. Select the I-O Groups icon from the 
Launcher.

2. Under Input Groups, select Parent input 
group.

3. Select up to 3 input groups by 
highlighting them in the Available Input 
Groups list.

4. Click on ADD.

5. Click on SAVE.
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Set Associated Output Groups
An input group or an input group schedule can 
control up to five output groups associated with 
it. This is useful when it is necessary to associate 
more than one type of activity with an input 
group or an input group event. For example, an 
input group event may be scheduled at 
sundown to trigger an output group made up of 
security lights that turn on when an exterior 
door is opened (either by force or by a valid 
badge swipe) and to trigger another output 
group made up of alarms that sound if an 
invalid badge swipe occurs.

To add or remove output groups to an input 
group or an input group schedule:

Available output groups
Up to five output groups from this list may 
be selected. Highlight the selection and click 
on ADD to add to the Selected output groups 
list.

Selected output groups associated with this 
input group (up to 5)

Once an output group has been added from 
the Available output groups list, it will 

NOTE

All outputs in a schedule must be associated with the 
same micro.
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appear in this list box. To delete a selection, 
highlight it and press REMOVE.

To associate an output group with an 
input group:

1. Select the I-O Groups icon from the 
Launcher.

2. Under Input Groups, select Associated 
output groups.

3. Select up to 5 output groups by 
highlighting them in the Available 
Output Groups list.

4. Click on ADD.

5. Click on SAVE.
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Configure Input Details
Physical inputs, such as sensors or detectors, 
must be described to the system. The 
description should include where each input 
point is connected, how it is wired to activate, 
what kind of state change(s) activates it, how 
long it remains detected before it activates, 
which input group is associated with it, and 
where messages about this input are routed.

The following fields are used to define an input:

Description
A physical description of the input, 
including a wiring address and/or a 
description of the location or purpose of the 
input (1 to 30 characters).

Facility
The facility to which the input is to be 
associated. Assigning inputs to a particular 
facility will allow you to group or assign 
them by facility. The facility can then be 
assigned to a facility operator based on that 
operator’s profiles.

Micro ID
The microcontroller to which the input is 
wired. This ID depends on hardware 
switches.

Routing
The destination of messages generated by an 
input state change.
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Route definition
A description (1 to 30 characters) of the 
message routing that will be used for alarm 
and activity monitors. It would generally 
correspond to one section of a site.

Input group
The input group that is activated when the 
input changes state. In the case of an 
unsupervised sensor assigned on a door 
screen, this field is left blank. A supervised 
sensor should be assigned to an input group 
configured to trigger a tamper alarm. If a 
sensor is not used on a door screen, it should 
be assigned to an input group.

Board
The logical board number where the DI is 
physically wired or controlled. It is 
dependent on hardware switches and 
configuration.

Address
The physical wiring position. This field 
indicates what digital input point on the 
board this input is using and depends on 
how the input is wired to the connector on 
the board.

Off to on
The time delay of the input’s effect when the 
input changes state from Off to On. This 
delay helps avoid false input detection. 
Select the number of seconds (0 to 32,767) 
required for the delay. Leaving this field 
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blank or selecting a 0 (zero) causes no delay. 
Set this delay to 0 for an Exit DI.

On to off
The time delay of the input’s effect when the 
input changes state from On to Off. This 
delay helps avoid false input detection. 
Select the number of seconds (0 to 32,767) 
required for the delay. Leaving this field 
blank or selecting a 0 (zero) causes no delay. 
Set this delay to 0 for an Exit DI.

Enable input
If selected, the microcontroller can detect set 
and/or reset states of the Input.

Normally closed
The inactive/quiescent state of the contacts 
as wired is closed.

Input point
If selected, the input will be configured as a 
standard input point.

Elevator point
If selected, the input will be configured as an 
elevator input.
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To define an input:

1. Select the I-O Groups icon from the 
Launcher.

2. Select Inputs.

3. Enter a physical description of the input.

4. Assign the input to a Facility, if desired.

5. Specify the wiring details, such as Micro 
ID, Board, and Address.

6. Specify Routing details for messages.

7. Specify the input group, if any, that is 
activated when the input state changes.

8. Specify Delay times, if desired.

9. Specify if the inactive state of the input is 
Normally Closed.

10. Specify if this is a standard or an elevator 
input point.

11. Click on SAVE.
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Schedule Input Group Events
Input group schedules describe an event that is 
scheduled to occur at a specific time on any 
number of days during the week (Runtime) or 
once at the start or end of a mode (Start/End). 
The schedule includes a description of the event, 
the input group that the event is scheduled for, 
and information about when the event is 
scheduled to occur. 

The following fields are used to describe an input 
group schedule:

Description:
A description (1 to 30 characters) of the 
purpose of the event, such as Access Horn on 
Back Reader or Disable Front Sensors.

Input group:
The input group affected by this event.

Online
If selected, all inputs in the group will be 
online during the schedule. Deselect this 
option to put all inputs in the group offline. 
For example, an input group made up of 
doors in the receiving area might be taken 
offline during certain hours.

Occurs
Day of the Week
The event takes place on the days selected in 
this field.
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At mode start
The event takes place whenever the mode 
selected is invoked, either by schedule or 
command.
At mode end
The event takes place whenever the mode 
selected is changed.
At time
Time when the event takes effect on the days 
selected.
Mode
The event takes place only when the system 
is in the mode selected. Normal and Holiday 
modes are already entered into the system 
and additional modes can be created as 
necessary. Normal mode does not usually 
require any start/end events to be 
scheduled.
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To define an input group event:

1. Select the I-O Groups icon from the 
Launcher.

2. Select Schedule input group events.

3. Enter a description of the input group 
event.

4. Assign the input group event to an input 
group.

5. Specify whether the Inputs in the group 
will be online or offline during the event.

6. Specify the details of when the event will 
occur.

7. Click on SAVE.
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Set Associated Output Groups for
Input Group Events

An input group or an input group schedule can 
control up to five output groups associated with 
it. This is useful when it is necessary to associate 
more than one type of activity with an input 
group or an input group event. For example, an 
input group event may be scheduled at 
sundown to trigger an output group made up of 
security lights that turn on when an exterior 
door is opened (either by force or by a valid 
badge swipe) and to trigger another output 
group made up of alarms that sound if an 
invalid badge swipe occurs.

To add or remove output groups to an input 
group or an input group schedule:

Available output groups
Up to five output groups from this list may 
be selected. Highlight the selection and click 
on ADD to add to the Selected output groups 
list.

NOTE

All outputs in a schedule must be associated with 
the same micro.

5_devices.fm  Page 37  Wednesday, May 17, 2000  4:55 PM



Input/Output Groups

Access Vision User’s Guide5.38

Selected output groups associated with this 
input group (up to 5)

Once an output group has been added from 
the Available output groups list, it will 
appear in this list box. To delete a selection, 
highlight it and click on REMOVE.

To associate an output group with an 
input group event:

1. Select the I-O Groups icon from the 
Launcher.

2. Under Schedule input group events, 
select Associated output groups.

3. Select up to 5 output groups by 
highlighting them in the Available 
Output Groups list.

4. Click on ADD.

5. Click on SAVE.
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Micros
Micros control specific input and output 
devices, such as readers, doors, and alarms. 
Communication-port characteristics, such as 
communication retries, polling intervals, port 
assignment, and micro addresses must be 
configured for the micro to work properly. 

Use this application to:

p Configure micro details. 

p Set micro properties. 

p Set retries and polling options. 

p Set input groups. 

p Configure dial-up communications. 

p Set dial-up options. 

p Set advanced properties. 

NOTE

In a network system, micros can only be 
created on a sub-host, not on a network host.
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Configure Micro Details
The following fields define the physical 
description of the micro:

Description 
A physical description of the micro (1 to 30 
characters), often including the mounting 
location of the micro or the building/floor 
controlled by the micro.

Micro address
A unique number that identifies a micro.

Valid values are 0 through 4095. For the 
Micro/5-P and Micro/4-P, the micro’s 
hardware address switches must exactly 
match the number specified. Once set, this 
field cannot be modified.

Time zone correction
The correction used to compute the micro’s 
local time from system time.

For example, if the host is in New York and 
the micro is in California, enter a “-3” in this 
field. If the host is in Austin, Texas and the 
micro is in Boca Raton, Florida, enter a “+1” 
in this field.

Facility
The facility to which the micro has been 
associated.
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Assigning micros to a particular facility 
allows you to group them. The facility can 
then be assigned to a facility operator based 
on that operator’s profiles.

Primary port
The main or primary asynchronous or 
network port defined in the operating 
system and Picture Perfect host where this 
micro is wired.

Secondary port
The alternate asynchronous port defined in 
the operating system and Picture Perfect 
when communications are lost on the 
primary line with the bi-directional option.

Select None without the bi-directional 
option.

Upstream micro
The micro description of the microcontroller 
wired directly upstream to this one.

Select Host if this is a head-of-line micro (the 
host is directly upstream).

Downstream micro
The micro description of the microcontroller 
wired directly downstream to this one.

Select None if this is an end-of-line micro or 
Host if this is an end-of-line bi-directional 
micro.

5_devices.fm  Page 41  Wednesday, May 17, 2000  4:55 PM



Micros

Access Vision User’s Guide5.42

Polling interval
If the host hasn’t communicated with this 
micro in this amount of time, the host will 
request communications with the micro 
(poll) to verify that the micro is still capable 
of communicating. Zeroes in these fields 
disable polling for this micro. Otherwise, 
enter the number of days, hours, minutes, 
and seconds you wish to poll this micro. The 
polling interval must be greater than the idle 
time for dial-up micros or polling will 
disable the idle timer.

To define a micro:

1. Select the Micros icon from the 
Launcher.

2. Enter a physical Description of the 
micro.

3. Enter the Micro address.

4. Enter the Time zone correction.

5. Assign the micro to a Facility.

6. Enter the port to which the micro is 
wired.

7. Identify upstream and downstream 
micros.

8. Specify polling intervals.

9. Click on SAVE.
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Set Micro Properties
The following fields describe the control 
features of the micro:

Configure
Online
Brings a direct micro online.

Offline
Forces a direct, dial-up, or network micro 
offline.

Nonexistent
Allows this micro to be configured before it 
goes online. For example, you may wish to 
configure a micro before it is actually 
installed.

Type
Normal
This micro is not configured as an elevator 
micro.

Elevator
This micro is configured as an elevator 
micro. Micro/4-P controllers cannot be 
assigned an elevator type.

NOTE

An elevator micro configured with multiple 
readers uses Reader 1 to control the elevator.
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To set micro properties:

1. Select the Micros icon from the 
Launcher.

2. Under Micros, select Properties.

3. By clicking the appropriate radio 
buttons, designate the configuration.

4. By clicking the appropriate radio 
buttons, designate the type of micro.

5. Click on SAVE.
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Set Retry Options
Use the following fields to assign the retries and 
interval times associated with the selected 
micro:

Upstream retries
The number of times a micro will try to 
contact its upstream micro before setting the 
Upstream Comm Failure input group.

Upstream retry interval
The number of seconds between Upstream 
Retries.

Downstream retries
The number of times a micro will try to 
contact its downstream micro before setting 
the Downstream Comm Failure input 
group.

Downstream retry interval
The number of seconds between 
Downstream Retries.

Host-micro retries (secs)
The number of times a host will try to 
contact the micro before setting the 
Downstream Comm Failure input group.

Host-micro retry interval (secs)
The number of seconds between Host-micro 
Retries.
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To set retry options:

1. Select the Micros icon from the 
Launcher.

2. Under Micros, select Retries.

3. Enter a number to represent the number 
of retries or the number of seconds 
between retries in each of the fields.

4. Click on SAVE.
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Set Input Groups
Use the following fields to select the 
appropriate input group for each of the five 
error conditions:

Badge history overflow
The input group triggered by the micro 
when the badge transaction buffer is filled to 
the Badge History Threshold percentage.

Alarm history overflow
The input group triggered by the micro 
when the alarm transaction buffer is filled to 
the Alarm History Threshold percentage.

Upstream comm failure
The input group triggered by the micro 
when it can’t communicate upstream.

Downstream comm failure
The input group triggered by the micro 
when it can’t communicate downstream, or 
the host can’t communicate with it.

Reader comm failure
The input group triggered by the micro 
when it can’t communicate with a reader 
port or a reader board.
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To set input groups:

1. Select the Micros icon from the 
Launcher.

2. Under Micros, select Input groups.

3. For each error condition listed, select an 
input group to be triggered.

4. Click on SAVE.
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Configure Dial-up Communication
Use the following fields to define the dial-up 
communications details for a dial-up micro:

Modem type
The type of modem connected to the micro.

Micro phone number
The phone number the host uses to call this 
micro.

Micro dialout prefix
Any special access codes, such as outside 
line access, long-distance access, or area 
code, with which the micro’s modem will 
need to prefix each host phone number 
before dialing the host.

Idle time
The amount of time the line has been idle 
before the modem connection is dropped.

This value must be greater than the micro’s 
upstream (host-micro) retry interval or the 
idle timer will cause the phone line to be 
dropped before messages are properly 
acknowledged.

Maximum connect time
The amount of time that the micro and host 
can be connected.
After this time has elapsed, the modem 
connection will be dropped. If both the idle 
timer and the maximum connect time are set 
to all zeroes, the host and micro maintain the 
connection continuously, once the 
connection is made.
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To configure dial-up communication:

1. Select the Micros icon from the 
Launcher.

2. Under Micros, select Dialup.

3. Select the modem type.

4. Enter the phone number for the micro.

5. Enter any special access code required 
when the micro dials the host.

6. Enter the idle and maximum connect 
times.

7. Click on SAVE.

5_devices.fm  Page 50  Wednesday, May 17, 2000  4:55 PM



Devices

Access Vision User’s Guide 5.51

5

Set Dial-up Options
The following fields define additional 
options available on dial-up micros:

Dial on updates
Always
The host calls the micro for any record 
changes that affect this micro.
Never
The host will not dial the micro for any 
record changes.
Ask operator
The host will prompt the operator if it must 
dial the micro for each record change.

Callback
Host
When the micro calls the host, the host flags 
the request, hangs up, and calls the micro 
back before accepting the transaction.
Micro
When the host calls the micro, the micro 
flags the request, hangs up and calls the host 
back before accepting the update.
None
No callbacks are performed.

Dial host on schedule update
The micro will dial the host every time it 
runs a schedule to report the schedule event.
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Dial on startup
The host will dial the micro when Picture 
Perfect starts.

To set dial-up options:

1. Select the Micros icon from the 
Launcher.

2. Under Micros, select Dialup.

3. Under Dialup, select Options.

4. Using the radio buttons, select dialup 
preferences for the micro and the host.

5. Click on SAVE.
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Set Advanced Properties
The following fields are used to set 
advanced options:

Facility code
This field applies only to Micro/4 8RP and 
Micro/2 8RP boards. When the 8RP has lost 
communication with the micro’s CPU board 
(degraded mode), it will grant access to any 
badge whose upper most digits match this 
field. If the field is left empty, the 8RP grants 
access to all badged in degraded mode (0 to 
5 characters).

Shunt code
With Shunting enabled on the area and 
reader, this code entered on a keypad allows 
a badgeholder to prop a door open for the 
time given on the door screen without 
triggering a Door Held Open alarm (0 to 10 
characters).

Alarm response code
With Keypad Alarm Response enabled, this 
code entered on a keypad allows an 
authorized badgeholder to respond to and 
reset an active alarm. This code must be 
different from the Shunt Code.

Badge history threshold
When the number of transactions in the 
micro’s local badge transaction table reaches 
this percentage, the micro triggers the Badge 
History Overflow input group.
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Alarm history threshold
When the number of transactions in the 
micro’s local alarm transaction table reaches 
this percentage,, the micro triggers the 
Alarm History Overflow input group.

To set advanced properties:

1. Select the Micros icon from the 
Launcher.

2. Under Micros, select Advanced.

3. Enter a code for the desired option.

4. If desired, enter a percentage which, 
when reached by Badge or Alarm 
history, will trigger a notification. 

5. Click on SAVE.
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Readers
Readers control access to doors and areas. In 
order for the system to process reader activity, 
how the reader operates must be defined as well 
as its association with areas, micros, and input 
groups. 

The Access Vision operator can add, delete, or 
modify readers in the system and set different 
characteristics for each reader as well as reader 
scheduled events.

Use this application to:

p Configure reader details. 

p Set reader properties. 

p Set reader states. 

p Set reader functionality.

p Schedule reader events. 

p Manage reader states for scheduled events. 

p Manage reader functionality for scheduled 
events.

NOTE

In a network system, readers can only be 
created on a sub-host, not on a network host.
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Configure Reader Details
The following fields are used to define how an 
access control reader is configured and which 
devices are associated with it.

Description 
A physical description of the reader (1 to 30 
characters).

Interval time
The maximum number of seconds between 
stages of a transaction, such as entering a 
PIN number in a keypad reader after a 
badge swipe, and/or between separate 
badge transactions on a double-badge 
reader; use zero (0) if the reader is not a 
keypad or double badge reader.

Micro ID
The microcontroller to which this reader is 
physically connected or by which it is 
controlled.

Facility
The facility to which the reader has been 
associated. Assigning readers to a particular 
facility allows you to group them. The 
facility can then be assigned to a facility 
operator based on that operator’s profiles.

Area
The area where this reader is assigned for 
access control.
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Terminal
The terminal where this reader is assigned 
as a badge issue reader.

Valid input group
The input group that triggers when the 
reader has read a valid badge.

Invalid input group
The input group that triggers when the 
reader has read an invalid badge.

Board
The logical board number where the reader 
is physically wired. It depends on hardware 
switch settings and configuration.

Address
The physical reader port.
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To define a reader:

1. Select the Reader icon from the 
Launcher.

2. Enter a physical Description of the 
reader.

3. Enter the maximum Interval Time.

4. Enter the Micro ID of the micro that 
controls the reader.

5. Assign the reader to a Facility.

6. Assign the reader to an Area.

7. Assign the reader to a Terminal.

8. Identify the Input Group to be triggered 
by a valid or an invalid badge read.

9. Enter the Board number where the 
reader is wired.

10. Enter the Address of the reader.

11. Click on SAVE.
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Set Reader Properties
The following fields describe the control 
features of the reader to the system:

Physical state
Enable
The reader can read badges.

Disable
The reader cannot read badges.

Logical state
Online
The reader can open a door.

Offline
The reader cannot open a door.

Number of badges
Single
The reader requires only one valid badge 
read to open the door.

Double
The reader requires two separate valid 
badge reads to open the door.

Options
Enable alarm shunting
The reader can accept a shunt code from a 
keypad, allowing the door to shunt the door 
contact for the keypad override time given 
on the Door screen.
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Enable scheduling
The micro will execute all schedule events 
for this reader.

Enable limited usage
When selected, this defines the reader as a 
reader that will only grant access to a 
badgeholder for the number of times 
specified in the Usage Count field in the 
Advanced section of the Badging feature. 
There is no limit to the number of readers 
that can be defined as limited usage readers.

Toggle reader
A badge swipe toggles the reader’s valid 
input group between On and Off states, as in 
arming or disarming a burglar alarm system. 
When a valid read occurs, the valid input 
group’s state is checked. If the state is On, it 
is changed to Off, if Off, it is changed to On.

Elevator reader
Selecting this button configures this reader 
as an elevator reader. A maximum of 8 
readers on a micro can be configured as 
elevator readers. 
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To set reader properties:

1. Select the Reader icon from the 
Launcher.

2. Under Readers, select Properties.

3. By clicking the appropriate radio 
buttons, designate:

• the physical and logical states of the 
reader.

• the number of badge reads required 
to open the door.

• other reader options.

4. Click on SAVE.
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Set Reader States
The reader state describes the physical state of 
the reader. A reader can be one of the following 
types:

Physical reader type
Badge only
A reader used only to read badges via a 
badge swipe.

Badge and keypad
A reader used in conjunction with a keypad, 
where a PIN, a duress code, a shunt override 
code, or an alarm response code can be 
entered in addition to the badge swipe. 

Keypad only 
A reader used only as a keypad, where, in 
lieu of a badge swipe, the badge encode 
number must be entered via the keypad.

Badge or keypad
A reader that can be used either as a badge 
reader or a keypad. If Badge is selected the 
reader is used only to read badges via a 
badge swipe. If Keypad is selected, the 
badge encode number is entered via the 
keypad. 

Swipe and show control
Enabled
Badge transactions on the reader cause the 
Activity Monitor to display a photo 
associated with the badge. This feature is 
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available when the optional Imaging 
package is installed.

Disabled
The Swipe and Show feature is not available 
on this reader or has been disabled.

Authorization required
Yes
Designates a reader that will display a photo 
on the Activity Monitor and require an 
operator to unlock a door

No 
Designates a reader that will display a photo 
on the Activity Monitor and will unlock a 
door without operator intervention.

NOTE

The Swipe and Show feature cannot be enabled 
when the reader is defined as Toggle.

NOTE

Access cannot be granted through a reader 
defined as Authorization Required while 
communications to the micro are down.

5_devices.fm  Page 63  Wednesday, May 17, 2000  4:55 PM



Readers

Access Vision User’s Guide5.64

To set reader states:

1. Select the Reader icon from the 
Launcher.

2. Under Readers, select Reader states.

3. By clicking the appropriate radio 
buttons, select:

• the reader type.

• if available, Swipe and Show options.

4. Click on SAVE.
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Set Reader Functionality
The reader function describes the logical state of 
the reader. The following fields define the 
reader function:

Logical reader function
Normal
A general reader used to grant access into an 
area.

Antipassback in
A reader that is used to log a badgeholder In 
when entering.

Antipassback out 
A reader that is used to log a badgeholder 
Out when exiting.

Time and attendance in / out
A reader that is used to log a badgeholder In 
and Out using the same reader by swiping 
the card the normal way for In and reversing 
the card or turning the card backwards for 
Out.

Time and attendance in 
A reader that is used to log a badgeholder In 
at the start of a work shift.

Time and attendance out 
A reader that is used to log a badgeholder 
Out at the end of a work shift.
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Antipassback type
If the Logical reader function is set to 
Antipassback in or Antipassback out, select 
the desired antipassback type for this reader. 

Global APB
Used as the default, this allows the reader to 
function as a normal antipassback reader. 
The antipassback status of a badge will not 
change unless the badge is used on an 
antipassback reader. 

Timed APB
When a badge is used on this type of reader, 
the badgeholder’s antipassback status will 
be set to In or Out and will return to Neutral 
after a defined period of time (as specified in 
the field, Timed APB Duration). A Timed 
APB reader is useful in a site where a 
badgeholder may enter a site by going 
through an APB In reader but is not 
required to exit through an APB Out reader. 
If this option is selected, a Timed APB 
Duration must also be defined. A Timed 
APB status is local to the micro. 

Reset timed APB immediately
This setting is used to reset the Timed APB 
status back to Neutral immediately 
following a badge swipe. 

Timed APB Duration
A value that represents how long a 
badgeholder’s Timed APB status (In or Out) 
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will be set when his badge is used on the 
reader, before being returned to Neutral. 

To set reader functionality:

1. Select the Reader icon from the Launcher

2. Under Readers, select Reader functions.

3. By clicking the appropriate radio 
buttons, designate the logical reader 
function.

4. If the logical reader function is APB In or 
APB out, designate the type of 
antipassback for the reader.

5. Click on SAVE.

NOTE

The Timed APB Duration value cannot exceed 
one day. A duration of 0 allows the micro to reset 
the status to Neutral immediately, producing the 
same effect as Reset Timed APB Immediately.
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Schedule Reader Events
Events are items that are executed at a 
scheduled time requiring a change to one or 
more of the operating characteristics of the 
reader. 
The following fields define the functions and 
features of a reader schedule:
Description

A unique description of the purpose of the 
event, such as Enable Keypad on Computer 
Door.

Reader
The reader affected by this event.

Occurs
Days of the Week
The event will take place on the days 
selected in this field.
At mode start
If selected, the event will take place 
whenever the mode selected is invoked, 
either by schedule or command.
At mode end
If selected, the event will take place 
whenever the mode selected is changed.
At time
Enter the time when the event takes effect on 
the days selected. 
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Mode
The event takes place only when the system 
is in the mode selected.

To schedule a reader event:

1. Select the Reader icon from the Launcher

2. Select Schedule events.

3. Identify the reader affected by this event.

4. Describe when the event is to occur.

5. Click on SAVE.
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Manage Reader States for
Scheduled Events

The schedule reader state describes the physical 
state of the reader during an event. 

Reader status
Online
Individual readers may open doors.

Offline
Individual readers may not open doors.

Number of badges 
Single
Single badge read required for door strike 
activation

Double
Double badge read required for door strike 
activation. A double badge read requires 
two complete, valid and distinct 
transactions.

Physical reader type
Badge only
Reader configured as a badge reader. A 
valid badge read is required for door strike 
activation.

Badge and keypad
Reader configured as a badge and keypad 
reader. A valid badge read and a valid 
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keypad entry is required for door strike 
activation.

Keypad only
Reader configured as a keypad reader. A 
valid keypad entry is required for door 
strike activation.

Badge or keypad
Reader configured as a badge or a keypad 
reader. A valid badge read or a valid keypad 
entry will activate the door strike.

Swipe and show control
Enabled
Badge transactions on the reader cause the 
Activity Monitor to display a photo 
associated with the badge. This feature is 
available when the optional Imaging 
package is installed.

Disabled
The Swipe and Show feature is not available 
on this reader or has been disabled.

NOTE

The Swipe And Show feature cannot be enabled 
when the reader is defined as Toggle.
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Authorization required
Yes
Designates a reader that will display a photo 
on the Activity Monitor and require an 
operator to unlock a door.

No 
Designates a reader that will display a photo 
on the Activity Monitor and will unlock a 
door without operator intervention

To manage reader states for scheduled 
events:

1. Select the Reader icon from the Launcher

2. Under Schedule events, select Reader 
states.

3. By clicking the appropriate radio 
buttons, designate:

4. the state of the reader during an event.

5. the number of badge reads required to 
open the door.

6. the physical reader type.

7. Swipe and Show control options.

8. Click on SAVE.

NOTE

Access cannot be granted through a reader 
defined as Authorization Required while 
communications to the micro are down.
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Manage Reader Functionality for
Scheduled Events

The reader function describes the logical state of 
the reader during a scheduled event. The 
following fields define the reader function:

Logical reader function
Normal
A general reader used to grant access into an 
area.

Antipassback in
A reader that is used to log a badgeholder In 
when entering.

Antipassback out 
A reader that is used to log a badgeholder 
Out when exiting.

Time and attendance in / out
A reader that is used to log a badgeholder In 
and Out using the same reader by swiping 
the card the normal way for In and reversing 
the card or turning the card backwards for 
Out.

Time and attendance in 
A reader that is used to log a badgeholder In 
at the start of a work shift.

Time and attendance out 
A reader that is used to log a badgeholder 
Out at the end of a work shift.
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Antipassback type
If the Logical reader function is set to 
Antipassback in or Antipassback out, select 
the desired antipassback type for this reader. 

Global APB
Used as the default, this allows the reader to 
function as a normal antipassback reader. 
The antipassback status of a badge will not 
change unless the badge is used on an 
antipassback reader. 

Timed APB
When a badge is used on this type of reader, 
the badgeholder’s antipassback status will 
be set to In or Out and will return to Neutral 
after a defined period of time (as specified in 
the field, Timed APB Duration). A Timed 
APB reader is useful in a site where a 
badgeholder may enter a site by going 
through an APB In reader but is not 
required to exit through an APB Out reader.

If this option is selected, a Timed APB 
Duration must also be defined. A Timed 
APB status is local to the micro. 

Reset timed APB immediately
This setting is used to reset the Timed APB 
status back to Neutral immediately 
following a badge swipe. 

Timed APB Duration
A value that represents how long a 
badgeholder’s Timed APB status (In or Out) 
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will be set when his badge is used on the 
reader, before being returned to Neutral. 

To set reader functionality for a 
scheduled event:

1. Select Schedule events.

2. Under Schedule events, select Reader 
functions.

3. By clicking the appropriate radio 
buttons, designate the logical reader 
function.

4. If the logical reader function is APB In or 
APB out, designate the type of 
antipassback for the reader.

5. Click on SAVE.

NOTE

The Timed APB Duration value cannot exceed 
one day. A duration of 0 allows the micro to reset 
the status to Neutral immediately, producing the 
same effect as Reset Timed APB Immediately.
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NOTES
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Monitoring

System Monitor
The System Monitor allows you to view the 
current status of selected devices, such as 
micros, readers, doors, and inputs. The 
operator can select which devices to monitor as 
well as which of its properties to display. 

The System Monitor interacts with the operator 
through a standard main application window 
as illustrated below.

Figure 6-1.  System Monitor
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To start using your System Monitor:

1. From the Monitor Workspace, create a 
monitor for each device that you will be 
viewing (micro, reader, door, inputs).

2. From the Device Pane area, select the 
devices for each monitor you created.

3. For each monitor, select the columns that 
you wish to be displayed.

4. For each monitor, review the default 
value of the properties displayed and 
change as necessary.

5. For each monitor, review the definitions 
of normal states and change as 
necessary. 

NOTE

In a network system, the System Monitor is 
available only from the sub-host.

In a redundant system, the System Monitor is 
available only from the primary host.
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Title Bar
The title bar is located along the top of a 
window. It contains the name of the application, 
the name of the active host, and the type of host, 
for example: Primary, Backup, Nethost, 
Subhost, or Standalone.

To move the window, drag the title bar. 

A title bar may contain the following elements:

• Application Control-menu button

• Maximize button

• Minimize button

• Name of the application

• Restore button

+ You can 
also move dialog 
boxes by 
dragging their 
title bars.
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Menu Bar
The System Monitor menu bar is comprised of 
the following standard Windows drop-down 
menus:

File 

The File menu offers the following commands:

New
Creates a new monitor file which displays a 
view of a monitor with selected preferences. 
These files are saved with the following 
extensions:

Micro monitor = .rsm

Reader monitor = .rsr

Door monitor = .rsd

Input monitor = .rsi

Open 
Opens an existing monitor file in a new 
window. You can open multiple monitors at 
once. Use the Window menu to switch 
among the multiple open monitors. 

Close 
Closes an opened monitor file. If you close a 
monitor without saving, you lose all changes 
made since the last time you saved it. Before 
closing an untitled monitor file, System 
Monitor displays the Save As dialog box 
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and suggests that you name and save the 
file.

Save 
Saves the active monitor display to its 
current name and directory. When you save 
a monitor file for the first time, System 
Monitor displays the Save As dialog box so 
you can name your file. If you want to 
change the name and directory of an 
existing file before you save it, choose the 
Save As command.

Save As
Saves and names the active monitor file. 
System Monitor displays the Save As dialog 
box so you can name your file. To save a file 
with its existing name and directory, use the 
Save command.

Open Workspace
Opens a previously saved workspace file in 
a new window. A workspace file ends with 
an .rsw extension and displays a template 
view of the monitors as they were displayed 
at the last save. Only active monitors are 
displayed when you open an .rsw file.

Save Workspace
Saves a template of how the selected 
monitors are displayed in a file with the 
extension .rsw. This is useful if certain 
operators monitor specific devices on a 
regular basis. For example, operators could 
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save their display as john.rsw, or 
steve.rsw.

 

Close Workspace
Closes an opened workspace file containing 
the active monitor(s). If you close a 
document without saving, you lose all 
changes made since the last time you saved 
it. Before closing an untitled workspace file, 
System Monitor displays the Save As dialog 
box and suggests that you name and save 
the file.

Print
Prints a monitor file. This command 
presents a Print dialog box, where you may 
specify the range of pages to be printed, the 
number of copies, the destination printer, 
and other printer setup options.

Print Setup
Selects a destination printer and its 
connection.

Recent File
Displays the files most recently used. To 
re-open a file, click on it.

NOTE

In order to save the workspace, all monitors 
displayed must have been saved.
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Exit
Exits the System Monitor. You can also use 
the Close command on the application 
Control menu. System Monitor prompts 
you to save documents with unsaved 
changes.

Edit 

The Edit menu offers the following commands:

Cut 
Deletes data from the monitor file and 
moves it to the clipboard. This command is 
unavailable if there is no data currently 
selected. Cutting data to the clipboard 
replaces the contents previously stored 
there.

Copy
Copies data from the monitor file to the 
clipboard. This command is unavailable if 
there is no data currently selected. Copying 
data to the clipboard replaces the contents 
previously stored there.

Paste
Pastes data from the clipboard into the 
monitor file at the insertion point. This 
command is unavailable if the clipboard is 
empty.
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View 

The View menu offers the following commands:

Toolbar
Shows or hides the toolbar which includes 
buttons for some of the most common 
commands in the System Monitor, such as 
File Open. A check mark appears next to the 
menu item when the toolbar is displayed.

Devices
Shows or hides the Device Selection Pane on 
the left side of the System Monitor. A check 
mark appears next to the menu item when 
the Device Selection Pane is displayed.

Status Bar
Shows or hides the status bar which 
describes the action to be executed by the 
selected menu item or depressed toolbar 
button, and keyboard latch state. A check 
mark appears next to the menu item when 
the Status Bar is displayed.

Advanced 
Turns the Advanced mode on or off. The 
default operational mode is Beginner. 
Beginner mode allows you to save the 
workspace without saving each monitor 
window individually. Default names are 
assigned to each monitor. These names can 
be changed by using the File/Save As option.

When the Advanced mode is active, you will 
be prompted to save any monitors that have 
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not been saved. You can assign whatever 
name you wish to the monitors. For 
example, if you have created a monitor to 
accommodate a schedule that opens selected 
doors between the hours of 8AM and 5PM, 
you may want to name the monitor 8 to 5. 
All monitors must be saved before the 
workspace can be saved. 

Regardless of mode, if a monitor is closed 
and it has been changed since the last Save 
operation, a prompt will appear, alerting 
you that it needs to be saved.

Facilities
Shows or hides the Selected Facilities 
dialog, which displays the currently selected 
facilities for this application.

Window 

The Window menu offers the following 
commands, which enable you to arrange 
multiple views of multiple documents in the 
application window:

New Window
Creates a new window that views the same 
workspace. You can open multiple monitor 
windows to display different parts or views 
of a monitor at the same time. If you change 
the contents in one window, all other 
windows reflect those changes. When you 
open a new window, it becomes the active 
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window and is displayed on top of all other 
open windows.

Cascade
Arranges windows in an overlapped 
fashion.

Tile
Arranges windows in non overlapped tiles.

Arrange Icons
Arranges icons of closed windows. If there is 
an open window at the bottom of the main 
window, then some or all of the icons may 
not be visible because they will be 
underneath this document window.

Help 

The Help menu offers the following commands, 
which provide you assistance with this 
application: 

Help Topics
Offers you an index to topics on which you 
can get help.

About
Displays the copyright notice and version 
number of your copy of the System Monitor.
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Toolbar
The toolbar is displayed across the top of the 
application window, below the menu bar. The 
toolbar provides quick mouse access to many 
tools used in the System Monitor.

To hide or display the toolbar, choose Toolbar 
from the View menu (ALT, V, T).

Open a new monitor file.

Open an existing monitor file. The System 
Monitor displays the Open dialog box in which 
you can locate and open the desired file.

Save the active monitor file with its current name. 
If you have not named the file, the System 
Monitor displays the Save As dialog box.

Remove selected data from the workspace and 
stores it on the clipboard.

Copy the selection to the clipboard.

Insert the contents of the clipboard at the 
insertion point.

Print the active monitor file.

Displays the About dialog, which contains the 
copyright notice and version number of your 
copy of the System Monitor.

Creates a Micro monitor.

Creates a Reader monitor.

Creates a Doors monitor.

Creates an Input monitor.
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Device Panes
The left side of the System Monitor screen 
displays micros, readers, doors and inputs in a 
tree-type hierarchy. The display is based on the 
facilities selected when Access Vision was 
initially launched. By expanding the tree, the 
corresponding micros will be displayed, and 
then may be further expanded to display the 
various devices to be monitored. 

There are three methods that can be used when 
selecting a micro or device:

Method 1:  Select one or more items, right click, 
and select ADD from the resulting 
menu.

Method 2:  Double click an item.

Method 3:  Select one or more items and drag 
and drop them onto the 
corresponding monitor. (This 
method requires that the monitor 
already be displayed. The other two 
methods will open the appropriate 
monitor automatically.)

The operator will need to select which Micros, 
Readers, Doors, and Inputs to be used for the 
status display. This can be done once and saved 
using the Save Workspace command. When the 
workspace or monitor is subsequently loaded, 
those preferences will be used.
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Status Bar
The status bar is displayed at the bottom of the 
System Monitor window. To display or hide the 
status bar, use the Status Bar command in the 
View menu.

The left area of the status bar describes actions 
of menu items as you use the arrow keys to 
navigate through menus. This area similarly 
shows messages that describe the actions of 
toolbar buttons as you depress them, but before 
you release them. If after viewing the 
description of the toolbar button command you 
wish not to execute the command, then release 
the mouse button while the pointer is off the 
toolbar button.

The right areas of the status bar indicate which 
of the following keys are latched down:

The Caps Lock key is latched down.

The Num Lock key is latched down.

The Scroll Lock key is latched down.

CAP

NUM

SCRL
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Monitor Workspace 
The device monitors are displayed on the right 
side of the System Monitor screen. Once the 
devices have been selected for the monitor, the 
properties or columns to be displayed, can be 
defined and/or modified. 

Each monitor is made up of columns that 
describe their respective properties and a 
context menu that is accessed by right clicking 
on the monitor.

Context Menu

Each monitor has a context menu which can be 
displayed by right clicking on the Monitor 
Workspace. They contain some or all of the 
following options:

Remove
Removes the selected item(s) from the 
display.

Select Columns
Displays a dialog from which the operator 
may select the columns to display on the 
monitor.

Properties
Displays a dialog that allows the operator to 
change the properties for the micro updating 
the monitor display.
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Define Normal State
Displays a dialog that allows the operator to 
select or change the definition of a normal 
state.

Refresh
Causes the display to be refreshed. 

Selecting Columns

The Column Selection window is accessed by 
right clicking on the monitor and selecting 
Select Columns from the Context menu. 
Initially, the Selected Columns list box will 
contain all of the Available Columns. Columns 
may be added or deleted as follows: 

Add
To add columns to the monitor, highlight 
the item(s) from the Available Columns list 
box and press the ADD button or double click 
on an item. The field(s) will appear in the 
Selected Columns list box and may be 
re-ordered by using the arrows provided. 

Remove
To remove columns from the monitor, 
highlight the item(s) from the Selected 
Columns list box and press the REMOVE 
button or double click on an item. The 
field(s) will appear in the Available 
Columns list box.

+ You can 
also press the 
F5 key.
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Ok
Press the OK button to accept the 
modifications and exit the Column Selection 
dialog.

Cancel
Press the CANCEL button to exit the Column 
Selection dialog without saving any 
changes.

Selecting Properties

The Properties window is accessed by right 
clicking on the monitor and selecting Properties 
from the Context menu. For the selected device, 
a window displays its properties on the left and 
their current value on the right. To change the 
value of a property, click on the cell to access a 
drop-down list of the possible values. 

Ok
Press the OK button to accept the 
modifications and exit the Properties dialog.

Cancel
Press the CANCEL button to exit the Properties 
dialog without saving any changes.
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Define Normal State 

The Define Normal State window is accessed by 
right clicking on the monitor and selecting 
Define Normal State from the Context menu. A 
window displays normal states on the left and 
their current value on the right. To change the 
definition of a normal state, click on the cell to 
access a drop-down list of the possible values.

Figure 6-2.  Define Normal State

Ok
Press the OK button to accept the 
modifications and exit the Define Normal 
State dialog.

Cancel
Press the CANCEL button to exit the Define 
Normal State dialog without saving any 
changes.
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To Create a Monitor

There are four ways to open a Monitor:

Method 1:  Click on the appropriate icon on the 
toolbar to create a Micro, Reader, 
Door, or Input Monitor. The Alert 
Status Monitor will be displayed 
automatically when an Alert 
message is received.

Method 2:  Double click on a device in the Device 
Pane. This will result in the 
appropriate monitor opening 
automatically.

Method 3:  Select New from the File menu on the 
Menu Bar or the New icon from the 
toolbar. Choose a monitor from the 
resulting dialog.

Method 4:  Right click on a device, and select 
ADD from the resulting pop-up.

6_Monitoring.fm  Page 18  Wednesday, May 17, 2000  4:57 PM



Monitoring

Access Vision User’s Guide 6.19

6

To Save a Monitor Workspace

The workspace may be saved so that when 
launched, the same device monitors will display 
the same properties. The workspace template of 
how the selected monitors are displayed is 
saved in a file with the extension .rsw. This is 
useful if certain operators monitor specific 
devices on a regular basis. For example, 
operators could save their display as 
john.rsw, or steve.rsw.

Figure 6-3.  Save Workspace

NOTE

In order to save the workspace, all monitors 
displayed must have been individually saved.
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To Close a Monitor Workspace

Use this command to close the workspace file 
containing the active monitor(s). If you close a 
document without saving, you lose all changes 
made since the last time you saved it. Before 
closing an untitled workspace file, System 
Monitor displays the Save As dialog box and 
suggests that you name and save the file.

Figure 6-4.  Close Workspace
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Alarm Monitor
Incoming alarms are displayed on the Alarm 
Monitor in the order of their priority. By 
selecting an alarm, the operator can view 
instructions on how to respond to a particular 
alarm and after responding, record the action 
taken.

The Alarm Monitor interacts with the operator 
through a standard main application window as 
illustrated below.

Figure 6-5.  Alarm Monitor
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To start using your Alarm Monitor:

1. From the Monitoring toolbar of the 
Application Launcher, select Alarm.

2. View any alarms that occur. To respond 
to an alarm, select it by highlighting it 
with your mouse.

3. Read the instructions in the Available 
Instructions box.

4. Take the appropriate action.

5. Record the action taken by entering a 
response. 

NOTE

In a network system, if logged into a network 
host, operators will see all alarms. If logged into 
a sub-host, they will see only those alarms that 
originate from that sub-host.
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Title Bar
The title bar is located along the top of a 
window. It contains the name of the application, 
Alarm.

To move the window, drag the title bar.

A title bar may contain the following elements:

• Application Control menu button

• Maximize button

• Minimize button

• Name of the application

• Restore button

Menu Bar
The Alarm Monitor menu bar is comprised of 
the following standard Windows drop-down 
menus:

File 

The File menu offers the following commands:

New
Creates a new monitor file which displays a 
view of a monitor with selected preferences.

+ You can 
also move dialog 
boxes by 
dragging their 
title bars.
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Print
Prints a monitor file. This command 
presents a Print dialog box, where you may 
specify the range of pages to be printed, the 
number of copies, the destination printer, 
and other printer setup options.

Print Preview
Displays the monitor file on the screen as it 
would appear printed.

Print Setup
Selects a destination printer and its 
connection.

Recent File
Displays the files most recently used. To 
re-open a file, click on it.

Exit
Exits the Alarm Monitor. You can also use 
the Close command on the application 
Control menu. 
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Edit 

The Edit menu offers the following commands:

Cut 
Deletes data from the monitor file and 
moves it to the clipboard. This command is 
unavailable if there is no data currently 
selected. Cutting data to the clipboard 
replaces the contents previously stored 
there.

Copy
Copies data from the monitor file to the 
clipboard. This command is unavailable if 
there is no data currently selected. Copying 
data to the clipboard replaces the contents 
previously stored there.

Paste
Pastes data from the clipboard into the 
monitor file at the insertion point. This 
command is unavailable if the clipboard is 
empty.
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View 

The View menu offers the following commands:

Toolbar
Shows or hides the toolbar which includes 
buttons for some of the most common 
commands in the Alarm Monitor, such as 
File Open. A check mark appears next to the 
menu item when the toolbar is displayed.

Facilities
Shows or hides the Selected Facilities dialog, 
which displays the currently selected 
facilities for this application. 

Help 

The Help menu offers the following commands, 
which provide you assistance with this 
application: 

Help Topics
Offers you an index to topics on which you 
can get help.

About
Displays the copyright notice and version 
number of your copy of the Alarm Monitor.
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Toolbar
The toolbar is displayed across the top of the 
application window, below the menu bar. The 
toolbar provides quick mouse access to many 
tools used in the Alarm Monitor.

To hide or display the toolbar, choose Toolbar 
from the View menu (ALT, V, T).

Clear all alarms from the Alarm Monitor.

Remove selected data from the workspace and 
stores it on the clipboard.

Copy the selection to the clipboard.

Insert the contents of the clipboard at the 
insertion point.

Print the information that appears on the Alarm 
Monitor screen.
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Status Bar
The status bar is displayed at the bottom of the 
Alarm Monitor window. 

The left area of the status bar describes actions 
of menu items as you use the arrow keys to 
navigate through menus. This area similarly 
shows messages that describe the actions of 
toolbar buttons as you depress them, but before 
you release them. If after viewing the 
description of the toolbar button command you 
wish not to execute the command, then release 
the mouse button while the pointer is off the 
toolbar button.

To the right, the status bar displays the number 
of new alarms, the total number of alarms 
displayed, and the highest priority displayed.

The far right area of the status bar indicates 
which of the following keys are latched down:

The Caps Lock key is latched down.

The Num Lock key is latched down.

The Scroll Lock key is latched down.

CAP

NUM

SCRL
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Alarm Window
The alarm window is made up of columns that 
describe the respective properties of the alarms 
and a context menu that is accessed by right 
clicking on the alarm.

Context Menu

The context menu contains the following 
options:

Remove
Removes the selected alarm(s) from the 
display, if the condition is reset.

Purge
Clears the selected alarm from the Alarm 
Monitor without regard to condition.

Select Columns
Displays a dialog from which the operator 
may select the columns to display on the 
monitor.

Properties
Displays a dialog that allows the operator to 
change the properties for the micro 
updating the monitor display.

Refresh
Causes the display to be refreshed. 
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Selecting Columns

The Column Selection window is accessed by 
right clicking on the alarm and selecting Select 
Columns from the Context menu. Initially, the 
Selected Columns list box will contain all of the 
Available Columns. Columns may be added or 
deleted as follows: 

Add
To add columns to the monitor, highlight the 
item(s) from the Available Columns list box 
and press the ADD button or double click on 
an item. The field(s) will appear in the 
Selected Columns list box and may be 
re-ordered by using the arrows provided. 

Remove
To remove columns from the monitor, 
highlight the item(s) from the Selected 
Columns list box and press the REMOVE 
button or double click on an item. The 
field(s) will appear in the Available 
Columns list box.

Ok
Press the OK button to accept the 
modifications and exit the Column Selection 
dialog.

Cancel
Press the CANCEL button to exit the Column 
Selection dialog without saving any 
changes.

6_Monitoring.fm  Page 30  Wednesday, May 17, 2000  4:57 PM



Monitoring

Access Vision User’s Guide 6.31

6

Selecting Properties

The Properties window is accessed by right 
clicking on the alarm and selecting Properties 
from the Context menu. For the selected alarm, 
a window displays its properties on the left and 
their current value on the right. To change the 
value of a property, click on the cell to access a 
drop-down list of the possible values. 

Ok
Press the OK button to accept the 
modifications and exit the Properties dialog.

Cancel
Press the CANCEL button to exit the 
Properties dialog without saving any 
changes.
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Alarm Window
The Alarm window is the portion of the screen 
where the alarms are displayed. In order to view 
all details, you may need to resize the columns 
by dragging them with your mouse. The alarm 
details include the following:

Priority
The priority level of the alarm message (1 to 
500, 1 being the highest priority). This 
priority was defined in the Alarms 
application and tells the system in which 
order it should alert the operator should 
multiple alarms occur at the same time. 

Description
The alarm’s text description as defined in the 
Alarms application.

Location
The input which is associated with the 
alarm. 

Condition
One of the following conditions:
Alarm
The alarm is in the active alarm state (either 
Open or Closed). The active alarm state for 
an alarm is defined in the Alarms 
application.
Reset
The alarm has been reset (turned off). It is no 
longer in the active alarm state.
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Tamper
The wiring of the alarm input has been cut 
or tampered with. 

Input State
One of the following states will be 
displayed:
Tamper States:

• Short/Ground

The wires connecting the input are 
registering less than normal or no 
resistance, indicating the contact has 
been bypassed.

• Open

The wires connecting the input are 
registering more than normal (infinite) 
resistance, indicating the connection has 
been broken.

Normal States:

• Open

The input contacts are in the open 
position. 

• Closed

The input contacts are in the closed 
position. 

N/A
This field is not applicable for this type 
of alarm.
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Host Date
Displayed in this column is the date the 
alarm occurred, as registered by the host.

Host Time
Displayed in this column is the time of day 
the alarm occurred, as registered by the host.

Process State
One of the following process states will be 
displayed:

Active
Alarms that have not been acknowledged.

Bumped
Active alarms that have been bumped to 
another terminal.

Notified
Active alarms sent to the Network Alarm 
Notification manager.

Remote
Alarms sent from a subhost to the network 
host.

Pending
Alarms which have been acknowledged but 
not reset.

Completed
Alarms which have been removed but not 
reset.
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Purged
Alarms which have been purged from the 
menu.

Count
The number of times this alarm has occurred 
without being acknowledged or reset.

Current Response Window
The Current Response Window is the portion of 
the screen where the response to a selected 
alarm is logged. You can continue to select an 
alarm to enter new responses. The previous 
responses appear in the Current Response 
Window and include the following details:

User ID
The User ID of the operator that entered or 
logged the response. This is helpful when 
multiple operators respond to an alarm.

Date
The date the response was logged.

Time
The time of day the response was logged.

Response Descriptions To Date
The action taken in response to the alarm. 
For example: Energized Fences or Called 911.
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Alarm Response Dialog
The Alarm Response dialog is accessed by 
selecting an alarm from the Alarm Window and 
left-clicking on it. 

Alarm instructions
This area displays the instructions, or the 
action to be taken, for the selected alarm. 
These instructions are those that have been 
defined and assigned to the alarm through 
the Alarms application.

Select response from list
Access Vision allows the operator to 
respond to (acknowledge) alarms by 
selecting from a pre-defined list of 
responses. 

Enter new response
If none of the responses on the selection list 
are appropriate, the operator can type a new 
response.

Purge
Enter a response, if desired, and press the 
PURGE button to clear the selected alarm, 
regardless of the condition. The system logs 
the alarm (and its responses) and deletes it 
from the Alarm Monitor.

Remove
Enter a response, if desired, and press the 
REMOVE button to clear the selected alarm if 
it is in a reset condition. The system logs the 
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alarm (and its responses) and deletes it from 
the Alarm Monitor.

Ok
After the appropriate response has been 
selected or typed, press the OK button to log 
the response in the Enter new response 
window, and exit the Alarm Responses 
dialog.

Cancel
Press the CANCEL button to exit the Alarm 
Response dialog without saving any 
changes.

Associating Sound to a New Alarm
You can customize your alarms to alert an 
operator when a new alarm comes in by adding 
sound. This is done by associating a .wav file 
to the new alarm event. Once sound is enabled 
for new alarms, the sound will occur every 
refresh period as long as alarms remain that 
have not been acknowledged.
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To associate a .wav file to a new alarm:

1. From your Windows desktop, select 
Start, Settings, Control Panel, then 
Sounds.

Result: A dialog similar to the following 
will display.

Figure 6-6.  Sounds

2. Scroll to Access Vision and highlight 
Alarm - New.

3. Click on BROWSE and navigate to the 
.wav file of your choice. Click on OK.

Result: The name of the .wav file you 
selected will appear in the Name box. 
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You may preview the sound by clicking 
on the arrow in the Preview area.

4. Click on OK to save the change in the 
current Windows sound scheme. To 
save the change as part of a different 
Windows sound scheme, click on the 
SAVE AS button and then continue with 
step 5 and step 6 below.

Result: The Save Scheme As dialog will 
display.

Figure 6-7.  Save Scheme As

5. Enter a name for your New Alarm 
sound.

6. Click on OK.
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Activity Monitor
The Activity Monitor is used to view Badge, 
Trace, Operator, and Tour activity. Details 
related to the various activities are viewed in a 
scrolling display. The operator can select which 
monitor he wishes to view from a Monitor 
Control dialog.

The Activity Monitor interacts with the operator 
through a standard main application window as 
illustrated below.

Figure 6-8.  Activity Monitor
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To start using your Activity Monitor:

1. From the Monitoring toolbar of the 
Application Launcher, select Activity.

2. Open the Monitor Control dialog by one 
of these two methods:

Method 1:  From the File menu, select 
New.

Method 2:  From the Toolbar, click .

Result: The Monitor Control dialog will 
display.

NOTE

In a network system, Badge and Tour activity 
can be monitored only from the sub-host. 

In a redundant system, the Activity Monitor 
is available only from the primary host.
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Figure 6-9.  Monitor Control

3. Select one or more activities to monitor 
by clicking on the appropriate check box.

4. Click on OK.

Result: The selected activity monitors 
will be displayed.
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Title Bar
The title bar is located along the top of a 
window. It contains the name of the application, 
Activity Monitor, followed by the currently 
selected activity.

To move the window, drag the title bar. 

A title bar may contain the following elements:

• Application Control menu button

• Maximize button

• Minimize button

• Name of the application

• Restore button

Menu Bar
The Activity Monitor menu bar is comprised of 
the following standard Windows drop-down 
menus:

File 

The File menu offers the following commands:

New
Creates a new monitor file which displays a 
view of a monitor with selected preferences.

+ You can 
also move dialog 
boxes by 
dragging their 
title bars.
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Print
Prints a monitor file. This command 
presents a Print dialog box, where you may 
specify the range of pages to be printed, the 
number of copies, the destination printer, 
and other printer setup options.

Print Preview
Displays the monitor file on the screen as it 
would appear printed.

Print Setup
Selects a destination printer and its 
connection.

Recent File
Displays the files most recently used. To 
re-open a file, click on it.

Exit
Exits the Activity Monitor. You can also use 
the Close command on the application 
Control menu. The Activity Monitor 
prompts you to save documents with 
unsaved changes.
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Edit 

The Edit menu offers the following commands:

Undo 
Reverses previous editing operation. The 
Undo command changes to Can't Undo on 
the menu if you cannot reverse your last 
action.

Cut 
Deletes data from the monitor file and 
moves it to the clipboard. This command is 
unavailable if there is no data currently 
selected. Cutting data to the clipboard 
replaces the contents previously stored 
there.

Copy
Copies data from the monitor file to the 
clipboard. This command is unavailable if 
there is no data currently selected. Copying 
data to the clipboard replaces the contents 
previously stored there.

Paste
Pastes data from the clipboard into the 
monitor file at the insertion point. This 
command is unavailable if the clipboard is 
empty.

Find
Performs a search to find specific text.
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Options

Swipe and Show
If this option is enabled, an image will be 
displayed when the reader is configured for 
Swipe and Show.

View 

The View menu offers the following commands:

Toolbar
Shows or hides the toolbar which includes 
buttons for some of the most common 
commands in the Activity Monitor, such as 
File Open. A check mark appears next to the 
menu item when the toolbar is displayed.

Status Bar
Shows or hides the status bar which 
describes the action to be executed by the 
selected menu item or depressed toolbar 
button, and keyboard latch state. A check 
mark appears next to the menu item when 
the status Bar is displayed.

Large Buttons
Displays the icons on the toolbar in an 
enlarged state. A check mark appears next to 
the menu item when the large icons are 
displayed.
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Facilities
Shows or hides the Selected Facilities 
dialog, which displays the currently selected 
facilities for this application.

Window

The Window menu offers the following 
commands, which enable you to arrange 
multiple views of multiple documents in the 
application window:

Cascade 
Arranges windows in an overlapped 
fashion.

Tile
Arranges windows in non-overlapped tiles.

Arrange Icons
Arranges icons of closed windows.

Help 

The Help menu offers the following commands, 
which provide you assistance with this 
application: 

Help Topics
Offers you an index to topics on which you 
can get help.

About
Displays the copyright notice and version 
number of your copy of the Activity 
Monitor.
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Toolbar
The toolbar is displayed across the top of the 
application window, below the menu bar. The 
toolbar provides quick mouse access to many 
tools used in the Activity Monitor.

To hide or display the toolbar, choose Toolbar 
from the View menu (ALT, V, T).

Select what kind of activities (Badge, Operator, 
or Tours) you want to monitor, press the NEW 
button to display the Monitor Control box.

Remove selected data from the workspace and 
store it on the clipboard.

Copy the selection to the clipboard.

Insert the contents of the clipboard at the 
insertion point.

Print the active monitor file.

Suspend the scrolling of activity on the monitor. 
The button will change and read RESUME. The 
system continues to queue activity messages 
and will resume scrolling the information when 
you press the RESUME button.

Search for specific text in the Activity Monitor 
buffer. Once the text is found, the corresponding 
line will be highlighted.
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Status Bar
The status bar is displayed at the bottom of the 
Activity Monitor window. To display or hide 
the status bar, use the Status Bar command in 
the View menu.

The left area of the status bar describes actions 
of menu items as you use the arrow keys to 
navigate through menus. This area similarly 
shows messages that describe the actions of 
toolbar buttons as you depress them, but before 
you release them. If after viewing the 
description of the toolbar button command you 
wish not to execute the command, then release 
the mouse button while the pointer is off the 
toolbar button.

To the right, the status bar displays the number 
of new alarms, the total number of alarms 
displayed, and the highest priority displayed.

The far right area of the status bar indicates 
which of the following keys are latched down:

The Caps Lock key is latched down.

The Num Lock key is latched down.

The Scroll Lock key is latched down.

CAP

NUM

SCRL
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Monitor Workspace 
By selecting File and then New from the Menu 
bar or by pressing the NEW button on the 
toolbar, you may select the kind of activities 
(Badge, Operator, or Tours) you want to 
monitor. 

Each monitor is made up of columns that 
describe their respective properties and a 
context menu that is accessed by right clicking 
on the monitor.

Context Menu
Each monitor has a context menu which can be 
displayed by right clicking on the Monitor 
Workspace. They contain some or all of the 
following options:

Remove
Removes the selected item(s) from the 
display.

Properties
For the selected device, a window displays 
its properties on the left and their current 
value on the right. To change the value of a 
property, click on the cell to access a 
drop-down list of the possible values. 

Pause
Allows the operator to freeze or suspend the 
scrolling of activity on the monitor.

Refresh
Causes the display to be refreshed. 
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Badge Monitor

The Badge Monitor displays badge activity as 
follows:

Double
Displays 1 or 2, which designates the first or 
the second activity on a double transaction 
reader. Access through double transaction 
readers is only granted when two complete, 
valid, and distinct transactions are 
presented to the reader. 

Description
Displays the type of activity that occurred, 
for instance: Valid, Invalid, Lost, Suspended.

Date
The date in the micro on which the badge 
activity occurred.

Time
The time in the micro on which the badge 
activity occurred.

Employee
The employee number of the badgeholder.

NOTE

In a network system, Badge activity can be 
monitored only from the sub-host. 
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Initials
The initials of the badgeholder.

Last Name
The last name of the badgeholder.

Reader
The description of the reader where the 
badge was read.

Area
The area to which the reader is assigned.

BID
The badge number or, if aliasing is used, the 
badge alias number.

Trace Monitor
The Trace Monitor displays badge activity only 
for badges which have been specially marked in 
Badges, Advanced, Card trace. The Trace 
Monitor will automatically appear whenever the 
Badge Monitor is active, and a trace badge is 
read.

Double
Displays 1 or 2, which designates the first or 
the second activity on a double transaction 
reader. Access through double transaction 
readers is only granted when two complete, 
valid, and distinct transactions are presented 
to the reader.
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Description
Displays the type of activity that occurred, 
for instance: Valid, Invalid, Lost, Suspended.

Date
The date in the micro on which the badge 
activity occurred.

Time
The time in the micro on which the badge 
activity occurred.

Employee
The employee number of the badgeholder.

Initials
The initials of the badgeholder.

Last Name
The last name of the badgeholder.

Reader
The description of the reader where the 
badge was read.

Area
The area to which the reader is assigned.

BID
The badge number or, if aliasing is used, the 
badge alias number.
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Operator Monitor
The Operator Monitor displays activity 
performed by system operators as follows:

Date
The date the modification to the system 
occurred.

Time
The time the modification to the system 
occurred.

Employee ID
The operator’s employee identification 
number.

Login ID
The login ID used by the operator when 
accessing the system.

Description
A description of the action performed, for 
example: Update, Insert, Delete.

Table
The database table that was modified by the 
operator.

Record Description
The record description or name as defined in 
the database table.

Field Description
The name of the field in the record that was 
modified.

Value
The new value of the modified field.
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Guard Tour Monitor

Guard Tours is an optional package and when 
installed, the Guard Tour Monitor is available to 
display activity related to Guard Tours as 
follows: 

Type
The tour type: Sequential or Random. A 
sequential tour is a tour where the order of 
points that are hit must be in a defined 
sequence. Each point is assigned a sequence 
number which indicates its position within a 
tour. A sequential tour ends when all of its 
points are hit in sequence. A random tour is 
a tour where all of its points do not need to 
be hit in a particular order. Every time this 
tour is executed, the order of points hit can 
vary. A random tour ends automatically 
when all of its tour points have been hit.

Description
A tour description. It is recommended that 
the tour type (random or sequential) be 
included in the tour description.

Date
The date the tour started/ended or the point 
was accessed.

NOTE

In a network system, Tour activity can be 
monitored only from the sub-host. 
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Time
The time of day the tour started/ended or 
the point was accessed.

Employee
The guard that conducted the tour.

Initials
The initial of the name appearing on the tour 
badge used on a reader, if the point accessed 
(tour hit point) was a reader.

Last Name
The last name appearing on the tour badge 
used on a reader, if the point accessed (tour 
hit point) was a reader.

Point Description
A description of the reader or input that was 
accessed.

Area Description
If the point accessed is a reader, the area 
description to which the reader is assigned.

Status
The current status of a tour which can be: 
Inactive (default), Active, Suspended, and 
Resumed. 
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Badging

Badges
The Badges feature allows the operator to 
assign badges, view badge designs, and with 
the optional Imaging package installed, create, 
edit, and print badge designs. 

This feature is used to:

p Specify personal data.

p Specify address information.

p Specify badge properties.

p Specify badge categories.

p Specify advanced options.

p Specify data for user fields.

p View or capture images and signatures.

p Select design for printing.

p View, create, or edit designs.

p Map designs to field values.
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Specify Personal Data

Figure 7-1.  Badges - Personal Data

NOTE

In a network system, badges can only be 
deleted from the network host, not from any 
sub-host.
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This area contains personal information, such 
as:

First name:
The badgeholder’s first name (up to 20 
characters). 

Last name:
The badgeholder’s last name (up to 30 
characters).

Initials:
The badgeholder’s initials (up to 5 
characters).

Employee ID:
An alphanumeric identification (1 to 12 
characters); for example, social security 
number.

Personnel type:
Press the arrow button to display a 
drop-down list of available personnel types; 
for example, Permanent, Temporary, Part 
Time.

NOTE

The Initials  (not the First Name) display on the 
Activity Monitor in front of the Last Name of 
the badgeholder. Therefore, use initials to 
distinguish between badgeholders who have 
the same last name.
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Badge status:
Select or edit the badge status by clicking 
one of the following badge status 
descriptions.

Active 
Can be granted access.

Suspended
Can't be granted access and can trigger 
logical inputs that can cause alarms.

Lost
Can't be granted access and can trigger 
logical inputs that can cause alarms.

Deleted
Can't be granted access and can trigger 
logical inputs that can cause alarms. 

Reissue Badge
This button will create a new badge record, 
copying all of the information from the 
currently selected badge, except for the 
Badge ID field. This allows the operator to 

NOTE

Changing a badge status to Deleted does not 
remove the badge record from the database. 
To permanently remove a badge record from 
the database and from all micros that have 
learned the badge, see the section "How to 
Remove a Badge Record " on page 7.6.
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reissue an existing badge with a new Badge 
ID, as in the case of a lost badge. To reissue a 
badge, the operator must have the special 
operation permission: Reissue badges. 
Additionally, if Imaging is installed on the 
host, the operator must be logged into the 
image server to reissue a badge. Otherwise, 
the Reissue Badge button will appear 
disabled. 

Badge format:
Click on the down arrow to display a list of 
available badge encode formats. This format 
is used for auditing. 

Badge ID:
The unique access control number encoded 
on or in the badge.

NOTE

Once the record is saved, you may not change 
the Badge ID Number, nor the Badge Format 
for security reasons; therefore, the badge 
format and badge ID values are "grayed out."
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HOW TO REMOVE A BADGE RECORD

CAUTION: This procedure permanently 
removes badge records from the database. It 
also removes the badge records from all micros 
that have learned the badges and have the 
badge records in their database.  Since it is 
possible to remove badge records that should be 
retained, you should back up your database 
before running this procedure.

1. Select the Badges icon from the Launcher.

2. Under Badges, perform a search and select 
the badge record to be deleted from the 
record list.

3. Change the badge status to Deleted by 
clicking on the radio button.

4. From the toolbar, click on Save.

5. Select the badge record from the record list 
again.

6. From the toolbar, click on Delete.

Result: A delete icon  will appear next to 
the badge record.

7. From the toolbar, click on Save.

Result: A confirmation dialog will appear.

8. Select Yes. 
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Specify Address Information

Figure 7-2.  Badges - Address 

This screen displays the badgeholder’s address 
(up to 40 alphanumeric characters) and phone 
information (up to 16 alphanumeric characters). 
The information is saved to and retrieved from 
the Picture Perfect host database and the field 
labels appear as they are defined on the host.
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Specify Badge Properties

Figure 7-3.  Badges - Properties

This screen displays the following badge 
properties:

Facility:
The facility to which the badge is assigned.

PIN:
The Personal Identification Number (1 to 10 
digits) the badgeholder must use as the 
keypad entry, when accessing a keypad or a 
badge and keypad reader.
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Department:
The department to which the badgeholder is 
assigned.

Date / time parameters
Issue:
The date and time when the badge is given 
to the badgeholder. If this field is left blank, 
the system will assign it.

Return:
The date and time when the badge has been 
returned.

Expires:
The date and time when the badge is no 
longer valid. If a date is given without a 
time, expiration is at 12:00:00AM (midnight) 
of the next day; if neither date nor time is 
given, the badge does not expire.

Now
Press to automatically enter the current date 
and time.

None
Press to clear the date and time fields.
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Specify Badge Categories

Figure 7-4.  Badges - Categories

A category assigned to an area can act as a lock 
on the doors in that area. When you assign that 
same category to a badge, the category functions 
as the badgeholder’s key to those doors. 

Available Categories List
The categories available for selection from 
this list are determined by the operator’s 
Permission group. A category may be 
selected more than once to accommodate 
different schedules.
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Select one or more rows and press the ADD 
button. Use the  key to select a range of 
categories or the  key to select multiple 
non-contiguous category entries.

Selected Categories List
The categories contained within a badge 
record. One of these categories must match a 
category assigned to the door area in order 
for the badgeholder to be granted access.

Double click a row to remove it or select a 
row and press the REMOVE button.

Type (indicated by an icon)

Unscheduled (Permanent)

Scheduled (Temporary)

Locked (no permission for the category
in that slot)

Slot
The slot number to which the category has 
been assigned. When a category is selected 
from the Available Categories list it is 
automatically assigned the next free slot in 
the badge record. A non-locked category slot 
can be changed by selecting it and then 
pressing the arrow on the Change Slot 
control to select a new slot. 

Category
The category located in the indicated badge 
record slot. 

Shift

Ctrl

No Icon
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Details
Summary information about the scheduling 
of the category including Start date/time, 
Stop date/time, the method (Continuous or 
Daily) of scheduling, and the days on which 
the schedule is active.

Add
This button is enabled if there exists 
sufficient free category slots to which the 
operator has update permission, in the 
badge record.

When pressed, the currently selected 
(highlighted) categories in the Available 
Categories list are added to the Selected 
Categories list as unscheduled categories 
and are assigned the next available slots. 

Remove
This button is enabled if the operator has 
permission to perform category 
management operations for badge holders.

When pressed, the currently selected 
(highlighted) categories in the Selected 
Categories list are removed from the badge 
record. The button is enabled whenever a 
non-locked category entry is selected. The 
badge record and any associated scheduled 
(temporary) category records are updated to 
reflect the deletion of the categories.
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Remove All
This button is enabled if the operator has 
permission to perform category 
management operations for badge holders.

When pressed, all non-locked categories in 
the Selected Categories list are removed 
from the badge record. The Selected 
Categories list will be cleared (except for 
locked categories) to show that there are no 
categories for the selected badge record. The 
badge record and any associated scheduled 
(temporary) category records are updated to 
reflect the deletion of all the categories. 

Change Slot:
This button is enabled if:

• the operator has permission to perform 
category management. 

• a single nonlocked category has been 
selected. 

• one or more slots are open. 

When enabled and the arrow is pressed, a 
list of available slots to which the category 
may be moved is displayed. Click on the 
new slot desired or click on the arrow to 
cancel the move.

Scheduling...
This button is enabled if the operator has 
permission to perform category 
management and there are sufficient 
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Scheduled (Temporary) category slots for 
the selected categories.

When pressed, the Category Scheduling 
Details dialog displays which allows the 
operator to schedule or unschedule the 
selected categories. 

Category Scheduling Details

This dialog allows you to specify details when 
scheduling categories or to remove schedules 
from categories.

Figure 7-5.  Category Scheduling Details

NOTE

Any changes made to badge records and 
associated scheduled (temporary) category 
records are proposed changes. The SAVE 
button on the toolbar must be pressed to save 
these changes to the host database.
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Start date/time:
The date and time of day that the scheduled 
(temporary) category should become active. 
Press the NOW button to set both the start 
date and time to the current host time.

Stop date/time:
The date and time of day that the scheduled 
(temporary) category should expire. Press 
the NOW button to set both the stop date and 
time to the current host time.

Method:
Continuous

A Continuous schedule type means that 
the category will be enabled at the Start 
Time of the Start Date and disabled at 
the Stop Time of the Stop Date.

Daily
A Daily schedule type means that the 
category will be enabled each day at the 
Start Time and disabled each day at the 
Stop Time. The default schedule type is 
Daily.

Days: 
You can restrict the days of the week that a 
scheduled (temporary) category will be 
enabled. A Week Day that is selected means 
that the schedule can run on that day. A 
Week Day that is not selected prevents the 
schedule from running on that day. By 
default, Monday through Friday are 
selected.
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Ok
When pressed, the new scheduling 
information for the selected categories is 
saved.

Cancel
Allows the operator to exit the dialog 
without changes. 

Help
Displays online documentation for the 
Category Scheduling Details screen.

Remove Schedule
This button is enabled if the selected 
categories are currently scheduled. When 
pressed, the dialog is exited and the 
schedule is removed from the categories. 

CAUTION

When the SCHEDULING button is pressed for a 
category that is currently unscheduled, the Category 
Scheduling Details dialog will contain default 
scheduling information that will be assigned to the 
category if the OK button is pressed. 
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To assign categories to a badge:

1. Select the Badges icon from the 
Launcher.

2. Under Badges, select Categories.

3. From the Available categories list box, 
select one or more rows and press ADD.

4. Click on SAVE.

To change a category slot:

1. From the Selected categories list box, 
select a non-locked category.

2. Click the arrow on the Change Slot 
control and select a new slot. 

3. Click on SAVE.

7_Badges.fm  Page 17  Wednesday, June 7, 2000  12:17 PM



Badges

Access Vision User’s Guide7.18

To create a scheduled (temporary) 
category:

1. Select one or more categories from the 
Selected categories list box.

2. Press the SCHEDULING button.

3. Enter the Scheduling details.

4. Press OK.

5. Click on SAVE.

To remove a schedule from a category:

1. Select one or more scheduled categories 
from the Selected categories list box.

2. Press the SCHEDULING button.

3. On the Scheduling details dialog, press 
the REMOVE SCHEDULE button.

4. Press OK.

5. Click on SAVE.
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Specify Advanced Options

Figure 7-6.  Badges - Advanced

Control:
Card trace
Enable this field to trace the activity of a 
particular badge.

Keypad response
Enable this field to give the badgeholder the 
ability to respond to special alarms 
requiring keypad input.
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Download upon save
If this field is enabled, any time a badge 
record is saved, it is downloaded to all 
micros.

Tour Badge
This field will be available if the Guard 
Tours package is installed on your host 
system. A security officer uses a designated 
tour badge to conduct guard tours of a 
facility at specified intervals. This badge will 
not operate for normal access control.

Usage:
Limited
Enable this field to limit the number of valid 
reads allowed when the badge is used in 
readers defined as limited usage readers.

To search for records with limited usage, the 
operator must check the Limited checkbox 
and then enter a numerical value in the 
Count field. All badges with that count will 
be displayed on the Record List. If the count 
has not yet been exhausted, the Usage Count 
column will show the current count value. 

Figure 7-7.  Badges - Limited Usage Count
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When the Count field indicates zero (0), 
the Limited Usage column will display 
Exhausted.

Figure 7-8.  Badges - Limited Usage Exhausted

Count
Enter a specific number in the Usage 
Count field. Each time the badge is used 
in a limited usage reader, the usage 
count is decremented by 1. When the 
count is 0, the badge will no longer grant 
access into a limited usage reader.

Antipassback:
When used in conjunction with antipassback 
readers, the antipassback status of a badge 
along with a category match, regulates its 
ability to open a door. For example, if a 
badgeholder enters an antipassback area 
without using his own badge (such as by 
following someone else through the door), 
that person will not be able to exit that area 
with his own badge, because the system 
never registered him as having entered that 
area. 

Antipassback status is global, meaning the 
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system will register whether someone is in 
or out, but it does not regulate the status on 
a per-reader basis.

If the badgeholder is required to use an 
antipassback reader, assign the badge an 
antipassback status of Neutral; otherwise 
leave these buttons unselected.

Neutral
Indicates an unknown user state (In/Out). 
The next time the badge is used in an 
antipassback reader, the system will set the 
appropriate In/Out state. Use this setting 
when creating a new badge, or when a 
badgeholder gets locked in or out of an 
antipassback area.

In
Indicates that the last use of this badge 
logged the badgeholder In to the 
antipassback reader’s area. This reflects 
information captured as of the moment the 
badge record was displayed. 

Out
Indicates that the last use of this badge 
logged the badgeholder Out of the 
antipassback reader’s area. This reflects 
information captured as of the moment the 
badge record was displayed. 

Privileged
Indicates that whenever this badge is read 
by an antipassback reader, the system 
ignores the antipassback status. Access is 
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granted if categories match the area, 
regardless of whether the badgeholder was 
logged into or out of the area. Assign this 
status to a badgeholder who has to use 
antipassback readers, but is not to be 
governed by them.

Reset timed APB status
This button sends a message to the micro to 
reset the Timed APB Status back to Neutral.

Last access date / time:
The date and time of the last access granted 
to this badge.

Last access reader:
Indicates which reader last granted access to 
this badge.

Select a reader and then press the SEARCH 
button to find all badges whose last reader 
access was with the selected reader.

+ The system 
supplies this data. 
Do not over-type 
data in this field.
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Specify Data for User Fields

Figure 7-9.  Badges - User Fields

User comment fields
Enter information (0 to 40 characters) in one 
or more user fields to identify the 
badgeholder (for example, license tag 
number). The number of user fields that 
appear and their label is determined during 
installation of the Picture Perfect host. 
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View or Capture Images and 
Signatures

Figure 7-10.  Badges - Images

NOTE

The capture and editing features of this dialog 
will be enabled if you have Access Vision 
Imaging installed.

For more detailed information on the features 
described on the following pages, refer to the 
ACCESS VISION IMAGING PLUG-IN 1.0 USER’S 
GUIDE.

7_Badges.fm  Page 25  Wednesday, June 7, 2000  12:17 PM



Badges

Access Vision User’s Guide7.26

Capture Photo1

Click on this button to capture an image. 
Depending on the input device used (such as 
a digital or video camera), the appropriate 
interface for capturing or loading a new 
image will appear. 

Right click on the image area to display the 
following options:

Capture…
Capture a new image. After a new image is 
captured, the Image Enhancement dialog 
box will appear.

Input Device…
Displays the Select Profile dialog that lists all 
available input devices, such as cameras or 
signature pads, available on your PC. 

Restore
Choosing this option will undo any changes 
made to the original image.

Crop…
This option allows you to adjust the size of 
the existing image without having to 
recapture it.

Enhance…
This option allows you to adjust the hue or 
contrast of the existing image without 
having to recapture it.

1. This feature will be disabled if you do not have Imaging installed.
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Compare
When a stored image is downloaded and a 
new one is captured, this option will be 
enabled on the pop-up menu allowing you 
to compare the newly-captured or edited 
image to the original.

Load
This will load only that particular image for 
the selected record.

Details…
Displays the Image Information dialog and 
is available only on images that have been 
saved to the host.

Capture Fingerprint1

This functionality has been reserved for a 
future release and is not yet available. 

Capture Signature1

Click on this button to capture a signature. 
The appropriate interface for capturing or 
loading a new signature will appear. Right 
click on the image area to display the 
following options:

Capture…
Captures a new signature. After a new 
signature is captured, the Crop dialog box 
will appear.

Input Device…
Displays the Select Profile dialog that lists 
all available input devices available on your 
PC. 
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Restore
Choosing this option will undo any changes 
made to the original signature.

Crop…
This option allows you to adjust the size of 
the existing signature image without having 
to recapture it.

Enhance…
This option will be disabled as it is not 
available for signature images.

Compare
When a stored signature image is 
downloaded and a new one is captured, this 
option will be enabled on the pop-up menu 
allowing you to compare the 
newly-captured or edited signature to the 
original.

Load
This will load only that particular signature 
image for the selected record.

Details…
Displays the Image Information dialog and 
is available only on signature images that 
have been saved to the host.

Load All Images
Click on this button to download all images, 
if any, associated with this badge record. 
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7

Select Design for Printing

Figure 7-11.  Badges - Print and Preview

NOTE

This dialog is only available if you have Access 
Vision Imaging installed.

For more detailed information on the features 
described on the following pages, refer to the  
ACCESS VISION IMAGING PLUG-IN 1.0 USER’S 
GUIDE.
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Use system default
The system default for a badge design is set 
in a manner similar to setting a printer 
default. When selected, the system default 
will be used when no other design is 
specified.
Design/Mapping:
The badge design or mapping used as the 
system default. 

Use design
When selected, a drop-down list of existing 
badge designs on the host system is 
displayed.

Use mapping
When selected, a drop-down list of existing 
design mappings on the host system is 
displayed.

Page Setup
Press to select the page orientation, Portrait 
or Landscape, and the number of cards to be 
displayed across and down a page. 

Preview
Select this option to view a badge-design file 
without printing to the printer.

NOTE

The label for this field will be Design if Use 
design is selected as the system default. It will 
appear as Mapping if Use mapping is 
selected as the system default. 
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7

Print
Select this option to print a badge.

Encoder Setup
Use to set up encoding command 
information to correctly encode magnetic 
stripe or smart card on a badge.

Encode only
Use this option to send magnetic stripe or 
smart chip encoding information only to the 
printer. The rest of the badge will not be 
printed.
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View, Create, or Edit Designs

Figure 7-12.  Badge Designs

NOTE

This dialog is only available if you have Access 
Vision Imaging installed.

For more detailed information on the features 
described on the following pages, refer to the 
ACCESS VISION IMAGING PLUG-IN 1.0 USER’S 
GUIDE.
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Description 
The name used to describe the badge design.

Filename
The name of the file containing the badge 
design as it appears in the Badge Designer. 
The filename is automatically generated by 
the system.

Edit design
Press to access the Badge Designer.

Set as printing default
Press to set the selected badge design as the 
system default.

Page setup
Press to select the orientation, Portrait or 
Landscape, of the badge design.

Preview
Press to see how the badge design will look 
before printing.

Print
Press to print a badge design. 
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Map Designs to Field Values

Figure 7-13.  Design Mapping

NOTE

This dialog is only available if you have Access 
Vision Imaging installed.

For more detailed information on the features 
described on the following pages, refer to the 
ACCESS VISION IMAGING PLUG-IN 1.0 USER’S 
GUIDE.
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Mapping
A design mapping will select a badge design 
based on a field value in the badge record. 
For instance, all members of a certain 
department require the same badge design.

Description:
The name that identifies the design 
mapping.

Field:
The field to be used for mapping: 
• Department
• Facility
• Personnel Type

Set as printing default
Press to set this field as the system printing 
default to be used when mapping badge 
designs.

Assign designs
Field value
A list of mapped field values for the selected 
field is displayed in this column.

NOTE

After a design mapping has been saved to the 
host, the field used for the mapping cannot be 
changed and will be “grayed out.”
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Design
The design assigned to the corresponding 
field value is displayed in this column.

Field Value:
A drop-down list of values associated with 
the selected field. 

Design:
A drop-down list of existing badge designs. 

To edit an existing design mapping:

1. Select the Badges icon from the 
Launcher.

2. Select Design mappings.

3. From the toolbar, press SEARCH.

4. Select a mapping description from the 
Record List on the right.

Result: All associated field values and 
designs will be displayed in the Assign 
designs list box.

5. Highlight the row you wish to change.

6. From the Design list, select a new design.

7. Click on SAVE.

+ The 
Default value 
allows you to set 
a default design 
for any values 
not directly 
mapped.

+ A Blank 
value removes 
the mapping 
from the Assign 
designs list.
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To create a new design mapping:

1. Select the Badges icon from the 
Launcher.

2. Select Design mappings.

3. From the toolbar, press NEW.

4. Enter a meaningful description to 
represent the mapping, such as 
Department design map.

5. Select the Field to be associated with the 
mapping by pressing on the down arrow 
and selecting either Department, 
Facility, or Personnel Type.

6. Add one or more field values to the 
Assign designs list by double clicking on 
a Field value from the drop-down list of 
values associated with the selected Field.

7. Associate a badge design to each field 
value by first highlighting the field value 
and then double clicking on a Design 
from the drop-down list of available 
badge designs.

8. Click on SAVE.
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To delete an existing design mapping:

1. Select the Badges icon from the 
Launcher.

2. Select Design mappings.

3. From the toolbar, press SEARCH.

4. Select a mapping description from the 
Record List on the right.

Result: All associated field values and 
designs will be displayed in the Assign 
designs list box.

5. From the toolbar, press DELETE.

Result: The selected mapping 
description in the Record List will be 
marked  for deletion. 

6. Click on SAVE.
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Failover in a 
Redundant 
System

In a redundant Picture Perfect system, if the 
host the terminal is logged into goes down, the 
Access Vision terminal will cease to function 
properly. A system using Access Vision 
terminals to monitor and recover from a system 
failover, should have two Access Vision 
terminals, one connected to the primary host, 
and the other to the backup host. Each should 
be on a separate network. This way the 
operator can access the live system from the 
Access Vision terminal that is connected to it. 

For each of the following events, the system 
administrator should be notified immediately.
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Events Occurring on the Primary 
System

p The operator is logged into the primary system 
while the operating system on the primary 
system crashes or PPRS is shutdown.

Result: The following will occur at the Access 
Vision terminal:

• The Access Vision session will hang, 
producing Server busy... messages.

• The host server will come back up, now 
acting as the backup server.

• Access Vision will display a pop-up dialog, 
informing the operator that the server is now 
running in backup mode and that anything 
they save will be overwritten.

• The Launcher application will change to 
display HostName (Backup) in the status 
bar at the bottom of the window.

• Any applications previously started while in 
primary mode, will allow the operator to 
save any changes. If they save these changes, 
however, they will be overwritten the next 
time the tables are swept from the new 
primary server. 

• The operator should note any unsaved 
changes made. These must be entered from 
the new primary server.

• Once the system administrator has 
recovered the downed system and restarts 
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PPRS, the operator should log off and log in 
again.

p The operator is logged into the primary system 
while the backup system crashes or PPRS is 
shutdown.

Result: The following will occur at the Access 
Vision terminal:

• The Access Vision session will remain 
functional.

• One alarm should appear on the Alarm 
Monitor: Disable Failover.

p The operator is logged into Access Vision while 
the network connection goes down.

Result: The following will occur at the Access 
Vision terminal:

• The Access Vision session will hang, 
producing Server busy... messages. It 
will prompt to retry or cancel. Each try will 
take about 3 minutes when the network 
connection is down. 

• If the Access Vision session hangs for over 
15 minutes, the operator’s Access Vision 
and Imaging license will time out, receiving 
an Unable to connect to license 
server. Check server connection 
message. Do not terminate the Access 
Vision application when this occurs. Access 
Vision must be exited from the Launcher to 
check in the license(s)) it has checked out.
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• The operator will be unable to save changes, 
or search for records while the network 
connection is down. 

• Once the network connection has been 
corrected, normal operation should resume. 

Events Occurring on the Backup 
System

p The operator is logged into the backup system 
while the operating system on the backup 
system crashes or PPRS is shutdown.

Result: The following will occur at the Access 
Vision terminal:

• The Access Vision session will hang, 
producing Server busy... messages.

• If the Access Vision session hangs for over 
15 minutes, the operator’s Access Vision 
license will time out and the following 
message will display: 

Unable to connect to license 
server. Check server connection . 

Do not terminate the Access Vision 
application when this occurs. Access Vision 
must be exited from the Launcher to check in 
the license(s) it has checked out.

• The host server will come back up, still 
acting as the backup server.
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• Once the system administrator has 
recovered the downed system and restarts 
PPRS, the operator should log off and log in 
again.

p The operator is logged into the backup system 
while the primary system crashes or PPRS is 
shutdown.

Result: The following will occur at the Access 
Vision terminal:

• The Access Vision session will remain 
functional.

• Two alarms should appear on the Alarm 
Monitor:

• Takeover

• Disable Failover.

• Access Vision will display a pop-up dialog, 
informing the operator that the server is 
now running in primary mode.

• The Launcher application will change to 
display HostName (Primary) in the 
status bar at the bottom of the window.

• Any applications previously started will still 
function in backup mode. Normally this 
would be View Only permission, and will 
not allow the operator to make any changes. 

• Starting the applications again from the 
Launcher will open them in primary mode, 
allowing edits, saves, and imaging 
capabilities. 
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p The operator is logged into Access Vision while 
the network connection goes down.

Result: The following will occur at the Access 
Vision terminal:

• The Access Vision session will hang, 
producing Server busy... messages. It 
will prompt to retry or cancel. Each try will 
take about 3 minutes when the network 
connection is down. 

• If the Access Vision session hangs for over 
15 minutes, the operator’s Access Vision 
license will time out, receiving an Unable 
to connect to license server. 
Check server connection message. 
Do not terminate the Access Vision 
application when this occurs. Access Vision 
must be exited from the Launcher to check in 
the license(s)) it has checked out.

• The operator will be unable to save changes, 
or search for records while the network 
connection is down. 

• Once the network connection has been 
corrected, normal operation should resume. 
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Access

The ability to enter or pass through, such as 
to enter a building by going through a 
door. See Access Control.

Access Control
A security system that controls an 
individual’s ability to enter an area 
(building, parking lot, room). Typically, 
readers protect doors or gates. Badges used 
in the readers permit or deny access based 
on a person’s authorization or permission.

AIX
Advanced Interactive Executive; the 
UNIX-based operating system developed 
by IBM; used for Picture Perfect.

Alarm Notification Message
An alarm alert message that displays on the 
Alarm Monitor when an alarm occurs.

Alarm State
When an alarm sensor detects an alarm 
condition (such as an open door), its 
contacts open or close (depending on the 
type of sensor and how it is wired to the 
system), and the sensor is said to be in 
alarm state.
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Allowable Open
The length of time a door can remain open 
before an alarm occurs.

Archive
To copy history transactions from the 
database to diskette or magnetic tape. Some 
fields are expanded from IDs to descriptions. 
Archives are used for later examination of 
transactions; archives cannot be restored.

Area
A logical grouping of readers and doors; 
used to control access.

Backup
To copy tables from the database to diskette 
or magnetic tape. A backup can be used to 
restore the system to a previous state or to 
recover from a failure.

Badge
A plastic card issued to each person who 
uses the facility. The system reads the 
information on the badge to determine 
whether or not to grant access to a person. 

Badge Encode Number
The hidden number that uniquely identifies 
each badge.

Badge-Issue Reader
A reader assigned to a workstation used to 
issue a badge.
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Badge Learn
Occurs when a micro checks with the host 
on an unknown badge and stores that badge 
information in its database. The next time 
the badge is presented to a reader connected 
to that micro, it will have the needed badge 
information.

Badge Reader
A device, usually located near a door, used 
to read badges. When a badge is presented 
to a badge reader, the system reads it and 
determines whether or not to unlock the 
door.

Badge Status
Indicates either the intended use of a badge 
(such as permanent or temporary) or its 
current condition (such as active or lost). 

Button
A button on a mouse pointing device; a 
graphical control button on a window frame 
or in a menu or picklist that works by 
“clicking” it. 

Category
A “lock” and “key” that controls access. 
Each area and badge has one or more 
assigned categories. If a category on a badge 
matches any of the categories on an area, 
the badge works as a “key” in readers 
assigned to that area. A category assigned to 
an area functions as a lock; a category 
assigned to a badge functions as a key.
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Click
The rapid press-and-release of a mouse 
button (without moving the mouse) that 
makes a “click” sound.

Close
A selection on some menus (or dialog boxes) 
that closes the window associated with the 
menu.

Cursor
A graphical symbol--usually a pipe (|) or 
block--that indicates your current input 
location on a screen. A mouse cursor shows 
where (to what selection) the mouse is 
pointing. A text cursor shows where the 
next character to be typed will appear on the 
screen.

Database
Configuration, transaction, and historical 
data stored on the hard disk of the host 
computer or the resident memory of a 
microcontroller. See Distributed Database and 
Relational Database.

Date Format
The order that the system requires for 
month, day, and year.

Digital Input
A physical sensing device used to monitor 
an electronic contact connected to a 
microcontroller. Also called a DI.
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Digital Output
A physical control device used to turn 
on/off an electronic contact connected to a 
microcontroller. Also called a DO.

Distributed Database
Resident database downloaded to a 
microcontroller that allows independent 
decision-making and faster response time.

Door
A database record that links the logical 
functions of a door with the door strike 
output, exit button, and door sensor inputs.

Door Forced Open
A logical alarm caused when the door opens 
without a valid badge read and the door 
contact reports the door-open state.

Door Open Too Long
A logical alarm caused when a door 
(unlocked by a valid badge read) remains 
open longer than the Allowable Open Time 
(a shunt time that starts when the door 
contact reports the door-open state).

Double Click
To click a mouse button twice in rapid 
succession without moving the mouse. See 
Click.
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Downstream
A relative position on a communication line 
originating at a host computer; for example, 
the second micro on a line is “downstream” 
from the first micro. See Micro.

Drag
To press and hold a mouse button while 
moving the mouse pointer. 

Duress Code
A special PIN number used (on a keypad 
reader) to signal emergency situations. 

Enabled Reader
A condition in which a reader is enabled to 
read badges. An enabled reader can be 
online or offline. See Online Reader and 
Offline Reader.

Encryption
The encoding of data for security purposes 
by converting standard data code into a 
proprietary code.

ENQ
An inquiry message to poll a micro to see if 
it is responding. 

Function Key
Keys on a computer’s keyboard labelled F1 
through F12 that may perform unique 
functions within a system. 
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Highlight
A graphic technique that provides a visual 
cue to the current selection or the current 
location of the input focus. Reverse video is 
typically used to “highlight” a selection.

Host Console
The host computer terminal used for AIX 
functions.

Icon
A graphic symbol that represents a function 
or an iconified window.

Informix
The relational database management system 
(RDBMS) used by the Picture Perfect system. 
See Relational Database.

Input
A digital input (DI) or a logical condition 
detected by the microcontroller. An input is 
assigned to an input group.

Input Group
A group of one or more digital inputs (or 
logical inputs) that can cause an alarm 
(and/or trigger output groups) when any 
(or all) inputs in the group are detected as 
true.

Keypad Override Code
See Shunt.
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LAN
A Local Area Network. X-Terminals are 
connected to the host computer via an 
Ethernet or Token-ring LAN.

Locale
A language and the location in which it is 
used. 

Login
The procedure used by operators to identify 
themselves to the system. To use the system, 
an operator must “log in” with a Login ID 
and Password. The Login ID is associated 
with a Permissions level that defines the 
functions an operator can perform. A 
Password provides secondary validation for 
that operator.

Logout
A security procedure that protects the 
system from unauthorized use. When an 
operator logs out, the system displays the 
Login screen and requires the next operator 
to log in.

Menu
A list of choices, often indicated by a group 
of icon buttons. The Main Menu lists major 
functions of the system. A Main Menu 
option may lead to a submenu or to a form. 

Message
Transaction information that the system 
displays. See also Alarm Message.
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Micro
See Microcontroller.

Microcontroller (micro)
The metal box containing the circuitry that 
controls the opening and closing of doors. 
Badge readers, alarm points, and digital 
output points are wired to micros, and 
micros are connected to the host computer. 

Mode
A set of schedules that defines how the 
system operates and specifies the 
characteristics of readers, areas, doors, and 
other system components. See Operating 
Mode.

Modem
Hardware device used to communicate 
between computer systems over telephone 
or other communications lines.

Mouse Button
One of two or three buttons on a pointing 
device, usually referred to as “left mouse 
button”, “middle mouse button”, and “right 
mouse button.” See Click, Drag, Double-Click, 
for ways to use a mouse button.

Offline
A condition in which the micro is not 
communicating with the host computer.

glossary.doc  Page 9  Wednesday, May 17, 2000  5:01 PM



Glossary

Access Vision User’s GuideGL.10

Offline Reader
A condition in which a reader is not enabled 
to release the doorstrike when a valid badge 
read occurs. Access attempts at an offline 
reader can be routed to the Activity Monitor 
and to printer(s) and online history.

Online
A micro is communicating with the host.

Online Reader
A reader is enabled to release the doorstrike 
when a valid badge read occurs. Access 
attempts at an online reader can be routed 
to the Activity Monitor, printer(s) and online 
history.

Option
A selection on a menu.

Output
A physical digital output (DO) that actuates 
devices such as a siren, a doorstrike, or 
lights, which can be triggered by an output 
group.

Output Group
A group of one or more outputs that can be 
triggered when activated by an associated 
input group.
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Password
A special code, used during login, that 
determines if an operator is authorized to 
log into the system.

Permissions
A level of operator permission to perform 
system functions. Each group of operators 
functions is a “permission group” that can 
be assigned to an operator authorized to 
perform those functions. See Login and 
Password.

Picklist
A window that displays a scrolling list of 
options for a certain category. You may be 
able to select several or only one of the 
options on the list, depending on the feature 
in use.

PIN #
A Personal Identification Number that 
identifies a person. If a facility uses both a 
keypad and badge reader, an employee 
presents his badge to the reader, then enters 
his PIN on the reader keypad.

Pop-up Menu
A menu that “pops up” when you press a 
button.

Priority
A number used to indicate the response 
priority of an alarm. The lower the priority 
number, the more serious the alarm.
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Process
One of many independent programs 
running at the same time in the computer.

Protected Field
An area of a screen where an operator 
cannot type in or change information.

Radio Button
A diamond-shaped button that allows only 
a single choice from a list of choices. See 
Toggle Button.

Readers
Badge readers are devices connected to the 
system that read the encoded badge 
numbers. They are usually located near 
doors or gates, or in elevators that the 
system controls.

Relational Database
A database that uses a table structure to 
store data. Relationships among tables are 
logically specified at the time of user access 
into the database; they are not built into the 
data structures themselves.

Response
Text that the operator selects or types when 
answering an alarm.

Restore
To re-display an iconified window.
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Schedule Event
A time-dependent change to a mode, area, 
reader, door, alarm, input group, or output 
group. See Operating Mode.

Scroll Bar
A graphical device used to move the 
contents of a window up, down, left, or 
right inside the frame. A scroll bar consists 
of a slider, scroll arrows, and a scroll area. 
To scroll, click on the scroll arrows or the 
scroll area or drag the slider.

Select
To choose an object to be acted upon or an 
action to be performed.

Shunt
Override an alarm on a door contact that 
detects an open state on the door.

A digital input device monitors the door 
state. If the door opens with a valid read (or 
exit device), the input device (a door 
contact) detects a state change but does not 
report the change until a shunt time elapses. 
The shunt time allows the badge holder 
enough time to get through the door. See 
Door Forced Open and Door Open Too Long.

To override a door sensor for a longer time, 
enter a keypad override code (a 
microcontroller-dependent code set on the 
Micros screen).
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Shutdown
To stop running the application and the 
operating system.

Status
The current condition of something, such as 
a badge or a micro. The Status form is used 
for viewing a micro’s current database to 
verify configuration and scheduling.

System Administrator
A full-function operator; an operator 
permission without any function 
restrictions.

Text Box
An area of the screen used for text entry. A 
text cursor appears in the box.

Toggle Button
A square button that appears with each item 
on a list where you can make multiple 
selections.

TPS
Transaction Processing System; the program 
that communicates with microcontrollers.

Transaction
Microcontroller activity.

UnixWare
The UNIX-based operating system developed 
by Univel; used for Picture Perfect.

glossary.doc  Page 14  Wednesday, May 17, 2000  5:01 PM



Glossary

Access Vision User’s Guide GL.15

Unlock Time
The length of time a door latch is to remain 
unlocked after a valid badge read (or after 
an exit button activates). This time allows 
the badge holder to open and pass through 
the door.

Upstream
A relative position on a communication line 
originating at a host computer. For example, 
the second micro on a line is “upstream” 
from the third micro, because the second 
micro is relatively closer to the host.

Window
A framed display that contains all or part of 
a menu, submenu, form, picklist, monitor, 
or message. 

xdm
The login utility used to allow an operator 
to log in on an X-Terminal. The operator 
uses an xdm window to enter a Login ID 
and a Password. The X-Window Display 
Manager (xdm) is the program that controls 
workstation windows.

X-Window System
A portable network-transparent window 
system that handles graphics and multiple 
fonts in a hierarchy of windows on a wide 
variety of bit-mapped display devices.
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